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Problems with Network Communication
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Problems with the Machine
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The Machine Cannot Be Powered On

• Check 1: Press the ON button.

• Check 2: Make sure that the power plug is securely plugged into the power cord
connector of the machine, then turn it back on.

• Check 3: Unplug the machine from the power supply, then plug the machine back
in and turn the machine back on after leaving it for at least 3 minutes.
If the problem is not resolved, contact the service center.
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Printing Does Not Start

• Check 1: Make sure that the power plug is securely plugged in, then turn the
machine on.
While any lamp on the operation panel is flashing, the machine is initializing. Wait until the lamp stops flashing and
remains lit.

Note
When printing large data such as a photo or graphics, it may take longer to start printing. While any lamp on the

operation panel is flashing, the computer is processing data and sending it to the machine. Wait until printing
starts.

• Check 2: Make sure that the machine is connected to your computer properly.
When the machine is connected to your computer with a USB cable, make sure that the USB cable is securely
plugged in to the machine and the computer, then check the followings:

• If you are using a relay device such as a USB hub, disconnect it, connect the machine directly to the computer,
and try printing again. If printing starts normally, there is a problem with the relay device. Consult the reseller of
the relay device for details.

• There could also be a problem with the USB cable. Replace the USB cable and try printing again.
When you use the machine over LAN, make sure that the machine is connected to the network with a LAN cable or is
set up correctly.

• Check 3: If you are printing from the computer and there are any unnecessary
print jobs, delete them.

Deleting the Undesired Print Job

• Check 4: Make sure that the inner cover (the cover of the disc tray) is closed.
If the inner cover is opened, close the inner cover and press the OK button on the machine.

• Check 5: Make sure that your machine's name is selected in the Print dialog box.
The machine will not print properly if you are using a printer driver for a different printer.
Make sure that your machine's name is selected in the Print dialog box.

Note
To make the machine the one selected by default, select Set as Default Printer.

• Check 6: Configure the printer port appropriately.
Make sure that the printer port is configured appropriately.

1. Log on as a user account with administrator privilege.

2. Select items from the Start menu as shown below.

• In Windows 7, select Devices and Printers from the Start menu.
• In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.
• In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware > Printers and

Faxes.

3. Open the properties of the printer driver for the machine.

• In Windows 7, right-click the "Canon XXX Printer" icon (where "XXX" is your machine's name), then select
Printer properties.

• In Windows Vista or Windows XP, right-click the "Canon XXX Printer" icon (where "XXX" is your
machine's name), then select Properties.
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4. Click the Ports tab to confirm the port settings.
Make sure that a port named "USBnnn" (where "n" is a number) with "Canon XXX Printer" appearing in the
Printer column is selected for Print to the following port(s).

Note
When the machine is used over LAN, the port name of the machine is displayed as

"CNBJNP_xxxxxxxxxx". "xxxxxxxxxx" is the character string generated from the MAC address or a character
string specified by the user when setting up the machine.

• If the setting is incorrect:
Reinstall the MP Drivers.

• Printing does not start even though the machine is connected to the computer using a USB cable and the
port named "USBnnn" is selected:
Click Start and select All programs, Canon Utilities, Canon My Printer, Canon My Printer, then select
Diagnose and Repair Printer. Follow the on-screen instructions to set the correct printer port, then select
your machine's name.
If the problem is not resolved, reinstall the MP Drivers.

• Printing does not start even though the port named "CNBJNP_xxxxxxxxxx" is selected when the machine
is used over LAN:
Launch IJ Network Tool, and select "CNBJNP_xxxxxxxxxx" as you confirmed in step 4, then associate the
port with the printer using Associate Port in the Settings menu.
If the problem is not resolved, reinstall the MP Drivers.

• Check 7: Is the size of the print data extremely large?
Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in the
displayed dialog to On.
* When On is selected for Prevention of Print Data Loss, print quality may be reduced.

• Check 8: Restart your computer if you are printing from the computer.
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Paper Does Not Feed Properly/"No Paper" Error Occurs

• Check 1: Make sure that paper is loaded.
Loading Paper

• Check 2: Make sure of the following when you load paper.
• When loading two or more sheets of paper, flip through the paper before loading.

• When loading two or more sheets of paper, align the edges of the sheets before loading.
• When loading two or more sheets of paper, make sure that the paper stack does not exceed the paper load

limit.
However, proper feeding of paper may not be possible at this maximum capacity depending on the type of paper
or environmental conditions (either very high or low temperature and humidity). In such cases, reduce the sheets
of paper you load at a time to less than half of the paper load limit.

• Always load the paper in portrait orientation, regardless of the printing orientation.

Important
When loading paper in the cassette, slide the paper guide on the front side to align with the corresponding

mark of page size. Load the paper with the print side facing DOWN, load the paper stack in the center of the
cassette, then slide the paper guides to align with the both edges of the paper stack.

Loading Paper

• Check 3: Check to see if the paper you are printing on is not too thick or curled.
Media Types You Cannot Use

• Check 4: Make sure of the following when you load Hagakis or envelopes.
• If a Hagaki is curled, it may not feed properly even though the paper stack does not exceed the paper load limit.

Load Hagakis with a zip code column toward the far end of the cassette (upper).
• When printing on envelopes, refer to Loading Paper, and prepare the envelopes before printing.

Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are placed in
landscape orientation, they will not feed properly.

• Check 5: Confirm that the media type and the paper size settings correspond with
the loaded paper.

• Check 6: Make sure that the inner cover (the cover of the disc tray) is closed
completely.
Paper does not feed properly if the inner cover is even slightly open.

Placing a Printable Disc

• Check 7: Clean the paper feed roller.
Cleaning the Paper Feed Roller

Note
Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.

• Check 8: If two or more sheets of paper feed from the cassette at once, clean the
inside of the cassette.
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For information on cleaning the inside of the cassette, refer to Cleaning the Pad in the Cassette.

• Check 9: Are the transport unit cover and the rear cover attached properly?
Refer to Rear View for the position of the rear cover.
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Print Results Not Satisfactory
If the print result is not satisfactory due to white streaks, misaligned lines, or uneven colors, confirm the paper and print
quality settings first.

• Check 1: Do the page size and media type settings match the size and type of the
loaded paper?
When these settings are incorrect, you cannot obtain a proper print result.
If you are printing a photograph or an illustration, incorrect paper type settings may reduce the quality of the printout
color.
Also, if you print with an incorrect paper type setting, the printed surface may be scratched.
In borderless printing, uneven coloring may occur depending on the combination of the paper type setting and the
loaded paper.
The method of confirming the paper and print quality settings differs depending on what you do with your machine.

To copy by operating the machine Confirm by using the operation panel on the machine.
Setting Items

To copy photo by operating the machine Confirm by using the operation panel on the machine.
Copying Photos

To print from your USB flash drive by operating the machine Confirm by using the operation panel on the machine.
Setting Items

To print photo on an online photo album by operating the
machine

Confirm by using the operation panel on the machine.
Printing Photos in Online Photo Album

To print from a PictBridge compliant device

Confirm by using your PictBridge compliant device.
About PictBridge Print Settings

Confirm by using the operation panel on the machine.
PictBridge print settings

To print from a mobile phone Confirm by using the operation panel on the machine.
Mobile phone print settings

To print from a computer Confirm by using the printer driver.
Printing with Easy Setup

• Check 2: Make sure that the appropriate print quality is selected referring to the
table in Check 1.
Select a print quality option suitable for the paper and image for printing. If you notice blurs or uneven colors,
increase the print quality setting and try printing again.

Note
When printing from a PictBridge compliant device, set the print quality setting by using the operation panel on

the machine.
You cannot make this setting from a PictBridge compliant device.
You cannot change the print quality setting when printing from a mobile phone.

• Check 3: If the problem is not resolved, there may be other causes.
See also the sections below:

Cannot Print to End of Job
Part of the Page Is Not Printed
No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks
Lines Are Misaligned
Line Does Not Print or Prints Partially
Image Does Not Print or Prints Partially
Printed Paper Curls or Has Ink Blots
Paper Is Smudged/Printed Surface Is Scratched
Back of the Paper Is Smudged
Vertical Lines Are Printed on the Sides of the Printout
Colors Are Uneven or Streaked
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Ink Is Not Ejected

• Check 1: Has the ink run out?
Check the Support Code on the LCD and take the appropriate action to resolve the error.

Support Code List

• Check 2: Is the orange tape or protective film remaining?
Make sure that all of the protective film is peeled off and the Y-shape air hole is exposed, as illustrated in (A).
If the orange tape is left as in (B), pull the orange tape and remove it.

• Check 3: Are the print head nozzles clogged?
Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.
Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:
Check to see if a particular color's ink tank is not empty.
If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head Cleaning and
try printing the Nozzle Check Pattern again.

• If the problem is not resolved after performing the Print Head Cleaning twice:
Perform the Print Head Deep Cleaning.
If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the machine and perform
another Print Head Deep Cleaning after 24 hours. When you turn the machine off, do not unplug it from the
power supply.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:
If Print Head Deep Cleaning does not resolve the problem, the print head may be damaged. Contact the service
center.
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Paper Jams
When paper is jammed, a troubleshooting message is displayed automatically. Take the appropriate action described in
the message.

• When a Support Code and a message are displayed on the computer screen:

• When a Support Code and a message are displayed on the LCD:

For details on how to remove the jammed paper, refer to Support Code List (When Paper Is Jammed).

Note
You can confirm the actions against errors with Support Codes on your computer or on the LCD by searching a

Support Code.
Click Here to Search
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If an Error Occurs
When an error occurs in printing such as the machine is out of paper or paper is jammed, a troubleshooting message is
displayed automatically. Take the appropriate action described in the message.
When an error occurs, a Support Code (error number) is displayed on the computer screen or the LCD.

• When a Support Code and a message are displayed on the computer screen:

• When a Support Code and a message are displayed on the LCD:

For details on how to resolve errors with Support Codes, refer to Support Code List.

Note
You can confirm the actions against errors with Support Codes on your computer or on the LCD by searching a

Support Code.
Click Here to Search

For details on how to resolve errors without Support Codes, see A Message Is Displayed.
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Problems Sending Faxes
Cannot Send a Fax
Cannot Perform Sequential Broadcasting by Redialing, or Cannot Dial Using the Numeric Buttons
Errors Often Occur When You Send a Fax

Cannot Send a Fax

• Check 1: Is the power turned on?
• You cannot send faxes if the power is turned off. Press the ON button to turn the power on.
• If you disconnected the power cord without turning off the power (one of the buttons on the operation panel is

lit), reconnecting it turns on the power automatically.
• If you disconnected the power cord after pressing the ON button to turn off the power (no buttons on the

operation panel are lit), reconnect it, then press the ON button to turn on the power.
• If the power was turned off due to power failure, etc., the power is automatically turned on when the power

failure is resolved.

Important
Confirm that all lamps on the operation panel are off before unplugging the power cord, then unplug the power

cord.
If a power failure occurs or you unplug the power cord, all faxes stored in the machine's memory are deleted.
For details on how to unplug the power cord, refer to Notice for Unplugging the Power Cord.

Note
If the faxes stored in the machine's memory are deleted by a power failure or unplugging the power cord, the list

of the faxes deleted from the machine's memory (MEMORY CLEAR REPORT) will be printed after turning the
machine on.
For details, see Summary of Reports and Lists.

• Check 2: Is the document being sent from memory or the fax being received into memory?
When the message for the transmission/reception is displayed on the LCD, a fax is being sent from/received into
machine's memory. Wait until the transmission/reception is complete.

• Check 3: Is the machine's memory full?
Delete contents in memory, then send a fax again.

Document Stored in Machine's Memory

• Check 4: Is the telephone line type set correctly?
Check the telephone line type setting and change it as necessary.

Setting the Telephone Line Type

• Check 5: Is Hook key setting set to Disable?
When you send a fax manually, dial the number with Enable selected for Hook key setting in Security control
under FAX settings, or dial the number using the telephone connected to the machine.

Security control

• Check 6: Is Dial tone detect set to ON?
Resend the fax after a while.
If you still cannot send the fax, select OFF for Dial tone detect in Advanced FAX settings under FAX settings.

Advanced FAX settings

• Check 7: Is the fax number registered correctly for speed dialing?
Check the recipient's fax/telephone number, correct the fax/telephone number registered to the speed dial code, then
send the document again.

Changing Registered Information

Note
You can check the information for speed dialing by printing CODED SPEED DIAL TELEPHONE NO. LIST.

Summary of Reports and Lists
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• Check 8: Does an error occur during transmission?
• Ensure that a message is displayed on the LCD. When a message is displayed on the LCD, check the cause.

A Message for Faxing Is Displayed on the LCD
• Print ACTIVITY REPORT and check for an error.

Summary of Reports and Lists

• Check 9: Is the document loaded properly?
Remove the document, then reload it on the platen glass or in the ADF.

Loading Originals

• Check 10: Does a printer error occur?
Ensure that an error message is displayed on the LCD. When an error message is displayed on the LCD, check the
cause.
When the error message with the support code is displayed, refer to Support Code List.
When the error message without the support code is displayed, refer to A Message Is Displayed.
If you are in a hurry, press the Stop button to close the message, then send the fax.

• Check 11: Is the telephone line connected correctly?
Reconnect the telephone line cable to the telephone line jack.

Basic Connection
If the telephone line is connected correctly, there is a problem with your telephone line. Contact your telephone
company and the manufacturer of your terminal adapter or telephone adapter.

Cannot Perform Sequential Broadcasting by Redialing, or Cannot Dial Using the Numeric
Buttons

• Check: Have you already selected the recipient from the redial history, or already dialed a number
by using the Numeric buttons?
You can dial one recipient by selecting from the redial history or by using the Numeric buttons as the recipient of
sequential broadcasting.
If you already have dialed by selecting from the redial history or by using the Numeric button, select the recipient from
the coded speed dial.

Errors Often Occur When You Send a Fax

• Check: Check the telephone line condition or the connection.
If the telephone line or connection is poor, reducing the transmission start speed may correct the error.
Reduce the transmission start speed on TX start speed in Adv. communication settings in Advanced FAX
settings under FAX settings.

Advanced FAX settings
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Problems Receiving Faxes
Cannot Receive a Fax, Cannot Print a Fax
Machine Does Not Switch Automatically between Voice and Fax Calls
Quality of Received Fax is Poor
Cannot Receive a Color Fax
Errors Often Occur When You Receive a Fax

Cannot Receive a Fax, Cannot Print a Fax

• Check 1: Is the power turned on?
• You cannot receive faxes if the power is turned off. Press the ON button to turn the power on.
• If you disconnected the power cord without turning off the power (one of the buttons on the operation panel is

lit), reconnecting it turns on the power automatically.
• If you disconnected the power cord after pressing the ON button to turn off the power (no buttons on the

operation panel are lit), reconnect it, then press the ON button to turn on the power.
• If the power was turned off due to power failure, etc., the power is automatically turned on when the power

failure is resolved.

Important
Confirm that all lamps on the operation panel are off before unplugging the power cord, then unplug the power

cord.
If a power failure occurs or you unplug the power cord, all faxes stored in the machine's memory are deleted.
For details on how to unplug the power cord, refer to Notice for Unplugging the Power Cord.

Note
If the faxes stored in the machine's memory are deleted by a power failure or unplugging the power cord, the list

of the faxes deleted from the machine's memory (MEMORY CLEAR REPORT) will be printed after turning the
machine on.
For details, see Summary of Reports and Lists.

• Check 2: Is the machine's memory full?
Print the received faxes stored in the machine's memory or save them on the USB flash drive, delete them from the
machine's memory, and have the sender resend the faxes.

Document Stored in Machine's Memory

• Check 3: Does an error occur during reception?
• Ensure that a message is displayed on the LCD. When a message is displayed on the LCD, check the cause.

A Message for Faxing Is Displayed on the LCD
• Print ACTIVITY REPORT and check for an error.

Summary of Reports and Lists

• Check 4: Is the telephone line cable connected to the external device jack?
Reconnect it to the telephone line jack.

Basic Connection

• Check 5: Is a different size of paper from that specified by Page size loaded?
If a different size of paper from that specified by Page size is loaded for printing faxes, the received faxes will not be
printed and will be stored in the machine's memory (Memory Reception). Load the same size of paper as that
specified by Page size, then press the OK button on the machine.

• Check 6: Is paper loaded?
If paper is not loaded, received faxes will be stored in the machine's memory without being printed (Memory
Reception). Load paper, then press the OK button.

• Check 7: Is the amount of remaining ink sufficient to print a fax?
If the amount of remaining ink is insufficient to print, received faxes will be stored in the machine's memory without
being printed (Memory Reception). Replace the ink tank, then print the faxes in the machine's memory.

Document Stored in Machine's Memory
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Note
If the machine was receiving faxes in the fax mode, printing will start automatically after the ink tank is replaced.

Replacing an Ink Tank
When the machine receives black & white faxes in the machine's memory, if 2-sided is selected for 2-

sidedPrintSetting in FAX paper settings in the Fax menu, selecting 1-sided may print the faxes.
You can set the machine to forcibly print a received fax even if the ink has run out.

Set Print when out of ink in Auto print settings under FAX settings to Print.
However, part or all of the fax may not be printed since the ink has run out.
Also, the contents of the fax will not be stored in the machine's memory.
If the ink has already run out, we recommend that Do not print be selected for Received documents in Auto
print settings under FAX settings to store the received fax in the machine's memory. After you replace the ink
tank and select Print for Received documents in Auto print settings, the fax stored in the machine's memory
will be printed automatically.

Auto print settings

• Check 8: Is the machine set to the appropriate receive mode?
Check the receive mode setting and change it to a mode suited to your connection if necessary.

Setting the Receive Mode

• Check 9: Is FAX reception reject set to ON?
Select OFF for FAX reception reject in Security control under FAX settings.
For details on how to set, see Rejecting Fax Reception.

• Check 10: Are there setting items set Reject in Caller rejection?
If you select Reject for any setting items in Caller rejection in Security control under FAX settings, the machine
rejects calls for setting item selected Reject.
For details on how to set, see Using the Caller ID Service to Reject Calls.

Machine Does Not Switch Automatically between Voice and Fax Calls

• Check: Is the receive mode set to FAX only mode?
If FAX only mode is selected for Receive mode settings, there will be no automatic switching between voice and
fax calls.
Set the receive mode to TEL priority mode, DRPD*1, or Network switch*2.
If the receive mode is TEL priority mode and an answering machine is connected to the machine, check whether a
proper message is played back when the answering machine answers.

Setting the Receive Mode
*1 This setting is available only in the US and Canada.
*2 This setting may not be available depending on the country or region of purchase.

Quality of Received Fax is Poor

• Check 1: Check the scan settings of the sender's fax machine.
Ask the sender to adjust the scan settings of the fax machine.

• Check 2: Is ECM RX set to OFF?
Select ON for ECM RX in Adv. communication settings in Advanced FAX settings under FAX settings.
If ECM RX is enabled, the sender's fax machine resends the fax after correcting errors automatically.

Advanced FAX settings

• Check 3: Is the sender's original document or scanning area of the sender's fax machine dirty?
The image quality of the fax is mainly determined by the sender's fax machine. Contact the sender and ask the
sender to check whether the scanning area of the fax machine is dirty.

• Check 4: Is ECM transmission/reception enabled although the line/connection is poor, or is the
sender's fax machine compatible with ECM?

• Select ON for ECM RX in Adv. communication settings in Advanced FAX settings under FAX settings.
Advanced FAX settings
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• Contact the sender and ask the sender to check whether the machine is set to enable ECM transmission.
If the sender's or recipient's fax machine is not compatible with ECM, the fax will be sent/received without
automatic error correction.

• Reduce the reception start speed on RX start speed in Adv. communication settings in Advanced FAX
settings under FAX settings.

Advanced FAX settings

• Check 5: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

Cannot Receive a Color Fax

• Check: Is ECM RX set to OFF?
If OFF is select for ECM RX in Adv. communication settings in Advanced FAX settings under FAX settings, the
machine cannot receive color faxes. The machine will disconnect the telephone line or receive color faxes in black &
white according to the setting of the sender's fax machine.
Set ECM RX to ON.

Advanced FAX settings

Errors Often Occur When You Receive a Fax

• Check 1: Check the telephone line condition or the connection.
If the telephone line or connection is poor, reducing the reception start speed may correct the error.
Reduce the reception start speed on RX start speed in Adv. communication settings in Advanced FAX settings
under FAX settings.

Advanced FAX settings

• Check 2: Is the sender's fax machine operating normally?
Contact the sender and ask the sender to check whether the fax machine is operating normally.
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Cannot Print on the Disc Label
Disc Label Printing Does Not Start
Disc Tray Does Not Feed Properly
Disc Tray Jammed

Disc Label Printing Does Not Start

• Check 1: Is the disc tray placed properly?
Open the inner cover (the cover of the disc tray), properly place the disc tray again, then press the OK button on the
machine to dismiss the error.
Use the disc tray supplied with this machine ("J" is on the upper side).
For details on how to place the disc tray, refer to Placing a Printable Disc.

• Check 2: Is the printable disc placed on the disc tray?
Place the printable disc on the disc tray properly, then press the OK button on the machine to dismiss the error.
Use the disc tray supplied with this machine ("J" is on the upper side).
For details on how to place the disc tray, refer to Placing a Printable Disc.

• Check 3: If disc label printing stops before it is complete, try the operation again.
If a certain period of time has elapsed while disc label printing is in progress, the machine stops initializing.
The machine resumes initializing by pressing the OK button.
Try the operation again following the on-screen instructions.

Disc Tray Does Not Feed Properly

• Check 1: Is the disc tray placed properly?
Open the inner cover, properly place the disc tray again, then press the OK button on the machine to dismiss the
error.
Make sure that you are using the disc tray supplied with the machine ("J" is on the upper side).
For details on how to place the disc tray, refer to Placing a Printable Disc.

• Check 2: Unrecognizable printable disc may be placed.
Canon recommends that you use printable discs specially processed to be printed on by an inkjet printer.

Disc Tray Jammed
Pull out the disc tray gently.
If the disc tray cannot be pulled out, turn the machine off, then turn the machine back on again. The disc tray will
automatically be ejected.
When the disc tray is pulled out, place the disc tray ("J" is on the upper side) again, then retry printing. Place the printable
disc properly referring to Placing a Printable Disc.
If the disc tray is still jammed, check if there is a problem with the printable disc.

Disc Tray Does Not Feed Properly
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Cannot Print from Picasa Web Albums (Cannot Access to Picasa Web
Albums)

• Check: Confirm the firmware version of the machine.
If Sorry, this service has been discontinued. It is no longer available. is displayed on the LCD when you try to
print from Picasa Web Albums, confirm the firmware version of the machine and update the firmware.

Firmware update
If the firmware version is earlier than 3.000, you cannot access to Picasa Web Albums. Confirm the firmware version
and update the firmware of the machine.
After you have updated the firmware, register the account of Picasa Web Albums again.

Registering the Account on Picasa Web Albums
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Problems with Network Communication
 Problems with the Machine While Using with Network
 Cannot Detect a Machine on a Network
 Other Problems with Network
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Problems with the Machine While Using with Network
 The Machine Stopped Working Suddenly
 Ink Remaining Level Is Not Displayed on Printer Status Monitor of the Machine
 Printing Speed Is Slow
 Cannot Use the Machine on Replacing an Access Point or Changing Its settings
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The Machine Stopped Working Suddenly
Cannot Communicate with the Machine After the Network Settings Are Changed
Cannot Communicate with the Machine over the Wireless LAN
Cannot Communicate with the Machine over the Wired LAN
Cannot Print, Scan, or Fax from a Computer Connected to the Network

Cannot Communicate with the Machine After the Network Settings Are Changed
Wait until the IP address is assigned to the computer. You may need to restart your computer.
Search for the printer again after confirming a valid IP address is assigned to the computer.

Cannot Communicate with the Machine over the Wireless LAN

• Check 1: Make sure that the machine is turned on.

• Check 2: Make sure that the network settings in the machine are identical with those of the access
point.
Refer to the instruction manual provided with the access point or contact its manufacturer to check the access point
settings, and then modify the machine settings.

How to Set a WEP/WPA/WPA2 Key

• Check 3: Make sure that the machine is not place as far away from the access point.
The access point is located indoors within the effective range for wireless communication. Locate the machine within
164 ft. / 50 m from the access point.

• Check 4: Make sure that there is no obstruction.
Wireless communication between different rooms or floors is generally poor. Adjust the location of the devices.

• Check 5: Make sure that there is no source of radio wave interference in your vicinity.
There may be a device such as a microwave oven using the same frequency bandwidth as the wireless station.
Place the wireless devices as far away from the interference source as possible.

• Check 6: Make sure that the network settings of the computer are correct.
For the procedures to connect a network device to the computer and set them up, refer to the instruction manual of
your network device or contact its manufacturer.

• Check 7: Make sure that the radio status is good and adjust the installation positions while
monitoring the radio status with IJ Network Tool.

Monitoring Wireless Network Status

• Check 8: Make sure that the valid wireless channel is used.
The wireless channel to be used may be limited depending on wireless network devices installed in the computer.
Refer to the instruction manual provided with your computer or your wireless network device to specify the valid
wireless channel.

• Check 9: Make sure that the channel set to the access point is valid to communicate with the
computer, confirmed in Check 8.
If not, change the channel set to the access point.

• Check 10: Make sure that the firewall of the security software is disabled.
If the firewall function of your security software is turned on, a message may appear warning that Canon software is
attempting to access the network. If the warning message appears, set the security software to always allow access.
If using any programs that switch the network environment, check their settings. Some programs will enable a firewall
by default.

• Check 11: When using a router, connect the printer and computer to the LAN side (same network
segment).
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If the problem is not resolved, insert the CD-ROM in the DVD/CD-ROM drive on your computer to start setting up again, or
access our web site through the Internet and download the latest MiniMasterSetup for your model.

• For placement:
Make sure that there is no barrier or obstacle between the access point and the machine.

Cannot Communicate with the Machine over the Wired LAN

• Check 1: Make sure that the machine is turned on.

• Check 2: Make sure that the LAN cable is connected properly.
Make sure that the machine is connected to the router with the LAN cable. If the LAN cable is loose, connect the
cable properly.
If the LAN cable is connected to the WAN side of the router, the cable is connected to the LAN side of the router.

If the problem is not resolved, insert the CD-ROM in the DVD/CD-ROM drive on your computer to start setting up again, or
access our web site through the Internet and download the latest MiniMasterSetup for your model.

Cannot Print, Scan, or Fax from a Computer Connected to the Network

• Check 1: Make sure that the network settings of the computer are correct.
For the procedures to set up the computer, refer to the instruction manual of your computer or contact its
manufacturer.

• Check 2: If the MP Drivers are not installed, install the MP Drivers.
Install the MP Drivers with the Setup CD-ROM.

• Check 3: When using wireless LAN, make sure that access control is not set to the access point.
For the procedures to connect an access point and set it up, refer to the instruction manual of your access point or
contact its manufacturer.

Note
To check the MAC address or the IP address of the computer, see Checking the IP Address or the MAC

Address of the Computer.
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Ink Remaining Level Is Not Displayed on Printer Status Monitor of the
Machine
Use the printer driver with bidirectional communication.
Select Enable bidirectional support in the Ports sheet of the properties dialog box of the printer driver.

How to Open the Printer Driver Setup Window
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Printing Speed Is Slow

• Check 1: The machine may be printing out or scanning a large job issued from
another computer.

• Check 2: When using wireless LAN, make sure that the radio status is good and
adjust the installation positions while monitoring the radio status with IJ Network
Tool.

Monitoring Wireless Network Status
Make sure that there is no barrier or obstacle between the access point and the machine. Wireless communication
between different rooms or floors is generally poor. The metal, concrete, or timber including the metallic material,
mud wall, or insulator may interrupt a wireless communication. If the machine cannot communicate with the computer
over a wireless LAN for the wall material, place the machine and the computer in the same room or floor.

• Check 3: When using wireless LAN, make sure that there is no source of
interference in your vicinity.
Since a device such as a microwave oven uses the same frequency bandwidth, it may cause interference. Place the
wireless devices as far away from the source of interference as possible.

32



Cannot Use the Machine on Replacing an Access Point or Changing Its
settings
When you replace an access point, perform network setup of the machine again.
To perform network setup again, access our web site through the Internet and download the latest MiniMasterSetup for
your model.
If the problem is not resolved, see below.

Cannot Communicate with the Machine After Applying MAC/IP Address Filtering or Entering a WEP/WPA/WPA2 Key to
the Access Point

When Encryption Is Enabled, Cannot Communicate With the Machine After the Encryption Type Was Switched on the
Access Point

Cannot Communicate with the Machine After Applying MAC/IP Address Filtering or Entering
a WEP/WPA/WPA2 Key to the Access Point

• Check 1: Confirm the access point setting.
Refer to the instruction manual provided with the access point or contact its manufacturer to confirm the access point
setting. Make sure that the computer and the access point can communicate with each other under this setting.

• Check 2: If you are performing MAC address filtering or IP address filtering at the access point,
confirm that the MAC address or IP address for both the computer or the network device and the
printer are registered.

• Check 3: If you are using a WEP/WPA/WPA2 key, make sure that the key for the computer or the
network device and the printer matches that set to the access point.
Besides the WEP key itself, the key length, key format, the key ID to use, and the authentication method must match
among the machine, the access point, and the computer.
Normally, select Auto for the authentication method. If you want to specify the method manually, select Open
System or Shared Key according to the setting of the access point.

How to Set a WEP/WPA/WPA2 Key

When Encryption Is Enabled, Cannot Communicate With the Machine After the Encryption
Type Was Switched on the Access Point
If the printer cannot communicate with the computer after the encryption type of the printer was switched, make sure that
encryption types for the computer and the access point matches that set to the printer.

Cannot Communicate with the Machine After Applying MAC/IP Address Filtering or Entering a WEP/WPA/WPA2 Key to
the Access Point
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Cannot Detect a Machine on a Network
 Cannot Detect the Machine When Setting up Network Communication
 The Machine Cannot Be Detected in the Wireless LAN
 The Machine Cannot Be Detected in the Wired LAN
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Cannot Detect the Machine When Setting up Network Communication
If the machine could not be detected on the network when setting up the network communication, confirm the network
settings before redetecting the machine.

Cannot Detect the Machine with the Wireless LAN: Check 1
Cannot Detect the Machine with the Wired LAN: Check 1

Note
You can set up the network communication via USB. To set up via USB, select the Set up the network connection

via USB check box on the Check Printer Settings screen and click Next.
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Cannot Detect the Machine with the Wireless LAN: Check 1

Are the machine and network device (router, access point, etc.) turned on?
Make sure that the machine is turned on.

Confirming that the Power Is On
Make sure that the network device (router, access point, etc.) is turned on.

If the machine or the network device is turned off:
Turn on the machine or the network device.
After turning on the machine or the network device, it may take some time until ready for use. After a while just turning on
the machine or the network device, click Redetect on the Check Printer Settings screen.
When the machine is detected, follow the instructions on the screen to continue to set up the network communication.

If the machine and the network device are turned on:
If the machine and the network device are turned on or if the machine could not be detected after clicking Redetect, go to
check 2.

Cannot Detect the Machine with the Wireless LAN: Check 2
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Cannot Detect the Machine with the Wireless LAN: Check 2

Are the computer and network device (router, access point, etc.) configured and can the
computer connect to the network?
Make sure that you can view any web pages on your computer.

If you cannot view any web pages:
Click Cancel on the Check Printer Settings screen to cancel to set up the network communication. After that, configure
the computer and network device.
For the procedures, refer to the instruction manuals supplied with the computer and network device, or contact their
manufacturers.
If you can view any web page after configuring the computer and network device, try to set up the network communication
from the beginning.

If you can view any web page:
Go to check 3.

Cannot Detect the Machine with the Wireless LAN: Check 3
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Cannot Detect the Machine with the Wireless LAN: Check 3

Is the wireless LAN setting of the machine enabled?
Make sure that the Wi-Fi lamp of the machine is lit blue.

If the Wi-Fi lamp is off:
The wireless LAN setting of the machine is not activated. Activate the wireless LAN setting of the machine.
After activating the wireless LAN setting, click Back to Top on the Check Printer Settings screen to try to set up the
network communication from the beginning.

If the Wi-Fi lamp is lit:
Go to check 4.

Cannot Detect the Machine with the Wireless LAN: Check 4
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Cannot Detect the Machine with the Wireless LAN: Check 4

Is the machine connected to the access point?
By using the operation panel of the machine, make sure that the machine is connected to the access point.
Press the MENU button, then select Setup > Device settings > LAN settings > Confirm LAN settings > WLAN setting
list.
Make sure that Connection on the LCD is set to Active.

If Connection is set to Inactive:
The machine may be placed far away from the access point. Place the machine near the access point temporarily, then
click Redetect on the Check Printer Settings screen.
When the machine is detected, follow the instructions on the screen to continue to set up the network communication.
If the machine cannot be detected, the machine is not connected to the access point. Connect the machine to the access
point.
Click Back to Top on the Check Printer Settings screen to try to set up the network communication from the beginning.

If Connection is set to Active:
Check the SSID of the WLAN setting list and confirm the setting is same as the access point which your computer
connects.
In Windows 7 or Windows Vista, you can confirm the SSID set for your computer from the wireless network
communication icon of the task tray.
If the SSIDs of the machine and your computer are different, click Back to Top on the Check Printer Settings screen to
try to set up the network communication from the beginning. When you try to set up, set the same SSID (access point) for
the machine and your computer.
If the SSIDs of the machine and your computer are same, go to check 5.

Cannot Detect the Machine with the Wired LAN: Check 5
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Cannot Detect the Machine with the Wireless LAN: Check 5

Does the firewall function of your security software or operation system for computer
interfere with setting up the network communication?
The firewall function of your security software or operation system for computer may limit communications between the
machine and your computer. Confirm the setting of firewall function of your security software or operation system or the
message appearing on your computer.

If the firewall function interferes with setting up:

• When the message appears on your computer:
If the message warning that Canon software is attempting to access the network appears on the computer, set the
security software to allow access.
Then click Redetect on the Check Printer Settings screen.
When the machine is detected, follow the instructions on the screen to continue to set up the network communication.

• When the message does not appear on your computer:
Cancel to set up, then set the security software to allow Canon software* to access the network.
* Set the security software to allow the file Setup.exe or Setup64.exe on win folder in DrvSetup folder of Driver
folder on the Setup CD-ROM to access the network.
After setting the security software, try to set up the network communication from the beginning.

Note
For the operation system firewall settings or the security software firewall settings, refer to the instruction manual of

the computer or software, or contact its manufacturer.

If there is no problem with the firewall settings:
Go to check 6.

Cannot Detect the Machine with the Wireless LAN: Check 6
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Cannot Detect the Machine with the Wireless LAN: Check 6

Check the settings of the access point.
Check the settings of the access point for the network connection such as IP address filtering, MAC address filtering, or
DHCP function.
For details on how to check the settings of the access point, refer to the instruction manual supplied with the access point
or contact its manufacturer.
After checking the settings of the access point, click Redetect on the Check Printer Settings screen.
When the machine is detected, follow the instructions on the screen to continue to set up the network communication.
If the problem is not resolved, select the Set up the network connection via USB check box on the Check Printer
Settings screen and click Next to set up the network communication via USB.
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Cannot Detect the Machine with the Wired LAN: Check 1

Is the LAN cable connected, and are the machine and the router turned on?
Make sure that the LAN cable is connected.
Make sure that the machine is turned on.

Confirming that the Power Is On
Make sure that the router is turned on.

If the LAN cable is connected and the machine or the network device is turned off:
Turn on the machine or the network device.
After turning on the machine or the network device, it may take some time until ready for use. After a while just turning on
the machine or the network device, click Redetect on the Check Printer Settings screen.
When the machine is detected, follow the instructions on the screen to continue to set up the network communication.

If the LAN cable is connected and the machine and the network device are turned on:
If the machine and the network device are turned on or if the machine could not be detected after clicking Redetect, go to
check 2.

Cannot Detect the Machine with the Wired LAN: Check 2
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Cannot Detect the Machine with the Wired LAN: Check 2

Are the computer and the router configured and can the computer connect to the network?
Make sure that you can view any web pages on your computer.

If you cannot view any web pages:
Click Cancel on the Check Printer Settings screen to cancel to set up the network communication. After that, configure
the computer and network device.
For the procedures, refer to the instruction manuals supplied with the computer and network device, or contact their
manufacturers.
If you can view any web page after configuring the computer and network device, try to set up the network communication
from the beginning.

If you can view any web page:
Go to check 3.

Cannot Detect the Machine with the Wired LAN: Check 3
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Cannot Detect the Machine with the Wired LAN: Check 3

Is the wired LAN setting of the machine enabled?
By using the operation panel of the machine, confirm the wired LAN setting of the machine.
Press the MENU button, then select Setup > Device settings > LAN settings > Change wireless/wired.
Make sure that Wired LAN active is selected on the LCD.

If Wired LAN active is not selected:
The wired LAN setting of the machine is not activated. Activate the wired LAN setting of the machine.
After activating the wired LAN setting, click Back to Top on the Check Printer Settings screen to try to set up the
network communication from the beginning.

If Wired LAN active is selected:
Go to check 4.

Cannot Detect the Machine with the Wired LAN: Check 4
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Cannot Detect the Machine with the Wired LAN: Check 4

Is the machine connected to the router?
By using the operation panel of the machine, make sure that the machine is connected to the router.
Press the MENU button, then select Setup > Device settings > LAN settings > Confirm LAN settings > LAN setting
list.
Make sure that Connection on the LCD is set to Active.

If Connection is set to Inactive:
The machine is not connected to the router. Connect the machine to the router.
Click Back to Top on the Check Printer Settings screen to try to set up the network communication from the beginning.

If Connection is set to Active:
Go to check 5.

Cannot Detect the Machine with the Wired LAN: Check 5
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Cannot Detect the Machine with the Wired LAN: Check 5

Does the firewall function of your security software or operation system for computer
interfere with setting up the network communication?
The firewall function of your security software or operation system for computer may limit communications between the
machine and your computer. Confirm the setting of firewall function of your security software or operation system or the
message appearing on your computer.

If the firewall function interferes with setting up:

• When the message appears on your computer:
If the message warning that Canon software is attempting to access the network appears on the computer, set the
security software to allow access.
Then click Redetect on the Check Printer Settings screen.
When the machine is detected, follow the instructions on the screen to continue to set up the network communication.

• When the message does not appear on your computer:
Cancel to set up, then set the security software to allow Canon software* to access the network.
* Set the security software to allow the file Setup.exe or Setup64.exe on win folder in DrvSetup folder of Driver
folder on the Setup CD-ROM to access the network.
After setting the security software, try to set up the network communication from the beginning.

Note
For the operation system firewall settings or the security software firewall settings, refer to the instruction manual of

the computer or software, or contact its manufacturer.

If there is no problem with the firewall settings:
Go to check 6.

Cannot Detect the Machine with the Wired LAN: Check 6
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Cannot Detect the Machine with the Wired LAN: Check 6

Check the settings of the router.
Check the settings of the router for the network connection such as IP address filtering, MAC address filtering, or DHCP
function.
For details on how to check the settings of the router, refer to the instruction manual supplied with the router or contact its
manufacturer.
After checking the settings of the router, click Redetect on the Check Printer Settings screen.
When the machine is detected, follow the instructions on the screen to continue to set up the network communication.
If the problem is not resolved, select the Set up the network connection via USB check box on the Check Printer
Settings screen and click Next to set up the network communication via USB.
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The Machine Cannot Be Detected in the Wireless LAN

• Check 1: Make sure that the machine is turned on.

• Check 2: Is Change wireless/wired in LAN settings under Device settings set to
Disable LAN?

• Check 3: When the machine is connected to the computer temporarily using a
USB cable, make sure that the USB cable is connected properly.
When you set up the wireless LAN connection using a USB cable or change the wireless LAN settings using IJ
Network Tool, connect the machine and the computer securely.

Connecting the Machine to the Computer Using a USB Cable

• Check 4: Make sure that the machine setup is completed.
If not, setup with the Setup CD-ROM.

• Check 5: When using IJ Network Tool, click Update to search for the printer
again.

Canon IJ Network Tool Screen

• Check 6: When searching for a printer over a network, make sure that the
machine is associated with the port.
When No Driver is displayed under Name in IJ Network Tool, there is no association. Select Associate Port on the
Settings menu, then associate the port with the printer.

When the Printer Driver Is Not Associated with a Port

• Check 7: Make sure that the network settings in the printer are identical with
those of the access point.
Refer to the instruction manual provided with the access point or contact its manufacturer to check the access point
settings, and then modify the machine settings.

How to Set a WEP/WPA/WPA2 Key

• Check 8: Make sure that there is no obstruction.
Wireless communication between different rooms or floors is generally poor. Adjust the location of the devices.

• Check 9: Make sure that the machine is not place as far away from the access
point.
The access point is located indoors within the effective range for wireless communication. Locate the machine within
164 ft. / 50 m from the access point.

• Check 10: Make sure that there is no source of radio wave interference in your
vicinity.
There may be a device such as a microwave oven using the same frequency bandwidth as the wireless station.
Place the wireless devices as far away from the interference source as possible.

• Check 11: Make sure that the network settings of the computer are correct.
Make sure that the computer can communicate with the printer and the access point over the wireless LAN.

• Check 12: Make sure that Enable bidirectional support is selected in the Ports
sheet of the properties dialog box of the printer driver.
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• Check 13: Make sure that the firewall of the security software is disabled.
If the firewall function of your security software is turned on, a message may appear warning that Canon software is
attempting to access the network. If the warning message appears, set the security software to always allow access.
If using any programs that switch the network environment, check their settings. Some programs will enable a firewall
by default.

• Check 14: When using a router, connect the printer and computer to the LAN side
(same network segment).

If the problem is not resolved, insert the CD-ROM in the DVD/CD-ROM drive on your computer to start setting up again, or
access our web site through the Internet and download the latest MiniMasterSetup for your model.
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The Machine Cannot Be Detected in the Wired LAN

• Check 1: Make sure that the machine is turned on.

• Check 2: Is Change wireless/wired in LAN settings under Device settings set to
Disable LAN?

LAN settings

• Check 3: Make sure that the LAN cable is connected properly.
Make sure that the machine is connected to the router with the LAN cable. If the LAN cable is loose, connect the
cable properly.
If the LAN cable is connected to the WAN side of the router, the cable is connected to the LAN side of the router.
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Other Problems with Network
 Forgot an Access Point Name, SSID, or a Network Key
 The Message Is Displayed on the Computer Screen During Setup
 The Admin Password Set to the Machine Was Forgotten
 Checking Information about the Network
 Packets Are Sent Steadily
 How to Restore the Machine's Network Settings to Factory Default
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Forgot an Access Point Name, SSID, or a Network Key
Cannot Connect with an Access Point to Which a WEP/WPA/WPA2 Key Is Set (You Forgot the WEP/WPA/WPA2 Key)
How to Set a WEP/WPA/WPA2 Key

Cannot Connect with an Access Point to Which a WEP/WPA/WPA2 Key Is Set (You Forgot
the WEP/WPA/WPA2 Key)
For information on how to set up the access point, refer to the instruction manual provided with the access point or contact
its manufacturer. Make sure that the computer and the access point can communicate with each other, then set up the
machine to match the settings of the access point.

How to Set a WEP/WPA/WPA2 Key
Refer to the instruction manual provided with the access point or contact its manufacturer and check the access point
settings. Make sure that the computer and the access point can communicate with each other, then set up the machine to
match the settings of the access point.

• When using WEP
The key length, key format, the key to use (one of 1 to 4), and the authentication method must match among the
access point, the printer, and the computer.
In order to communicate with an access point that uses automatically generated WEP keys, you must configure the
machine to use the key generated by the access point by entering it in hexadecimal format.
Normally, select Auto for the authentication method. Otherwise, select Open System or Shared Key according to
the setting of the access point.
When the WEP Details screen appears after clicking Set on the Search screen, follow the on-screen instructions and
set the key length, the key format, the key number, and the authentication to enter a WEP key.
For details, see Changing the WEP Detailed Settings.

• When using WPA or WPA2
The authentication method, passphrase, and dynamic encryption type must match on the access point, the machine,
and the computer.
Enter the passphrase configured on the access point (a sequence of between 8 and 63 alphanumeric characters, or
a 64-character hexadecimal number).
Select either TKIP (Basic Encryption) or AES (Secure Encryption) for the dynamic encryption method.
For details, see Changing the WPA or WPA2 Detailed Settings.

Note
This machine supports WPA-PSK (WPA-Personal) and WPA2-PSK (WPA2-Personal).
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The Message Is Displayed on the Computer Screen During Setup
The Enter Password Screen Is Displayed During Setup
The Screen for Setting the Encryption Is Displayed After Selecting the Access Point in the Search Screen
"You are connecting the machine to the non encrypted wireless network" Is Displayed

The Enter Password Screen Is Displayed During Setup
The following screen is displayed if an administrator password is set to the machine which has already been set up.

Enter the administrator password you have set.
Changing the Settings in the Admin Password Sheet

The Screen for Setting the Encryption Is Displayed After Selecting the Access Point in the
Search Screen
This screen is displayed automatically if the selected access point is encrypted. In this case, configure the details to use
the same encryption settings set to the access point.
For information on the encryption settings, see Changing the Settings in the Wireless LAN Sheet.

"You are connecting the machine to the non encrypted wireless network" Is
Displayed
Security is not configured on the access point. The machine can still be used, so continue the setup procedure to
complete it.

Important
If you connect to a network that is not protected with security measures, there is a risk of disclosing data such as

your personal information to a third party.
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The Admin Password Set to the Machine Was Forgotten
Initialize the LAN settings.

How to Restore the Machine's Network Settings to Factory Default
After initializing the LAN settings, setup with the Setup CD-ROM.
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Checking Information about the Network
Checking the IP Address or the MAC Address of the Machine
Checking the IP Address or the MAC Address of the Computer
Checking If the Computer and the Machine, or Computer and the Access Point Can Communicate
Checking the Network Setting Information

Checking the IP Address or the MAC Address of the Machine
To check the IP address or the MAC address of the machine, display the network setting information using the operation
panel of the machine or print out the network setting information of the machine.

LAN settings
Printing Out Network Setting Information

To display the network setting information using IJ Network Tool, select Network Information on the View menu.
Canon IJ Network Tool Screen

Checking the IP Address or the MAC Address of the Computer
To check the IP address or MAC address assigned to the computer, follow the procedure below.

1. Click Start > All Programs > Accessories > Command Prompt.

2. Enter "ipconfig/all" and press the Enter key.

The IP addresses and the MAC addresses of the network devices installed on your computer are displayed. When
the network device is not connected to the network, the IP address is not displayed.

Checking If the Computer and the Machine, or Computer and the Access Point Can
Communicate
To check that communication is available, perform the ping test.

1. Click Start > All Programs > Accessories > Command Prompt.

2. Type the ping command and the IP address of the target printer or the target access point, and then press the Enter
key.
ping XXX.XXX.XXX.XXX
"XXX.XXX.XXX.XXX" is the IP address of the target device.
If the communication is available, a message such as the following is displayed.
Reply from XXX.XXX.XXX.XXX: bytes=32 time=10ms TTL=255
When Request timed out is displayed, the communication is not available.

Checking the Network Setting Information
To check the IP address or the MAC address of the machine, display the network setting information using the operation
panel of the machine or print out the network setting information of the machine.

LAN settings
Printing Out Network Setting Information
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Packets Are Sent Steadily
While IJ Network Scanner Selector EX is enabled, it periodically transmits packets to check whether it can communicate
with the machine over the network. When using the computer in a network environment other than the one used to set up
the machine, disable IJ Network Scanner Selector EX.

To disable IJ Network Scanner Selector EX, right-click the  icon on the task tray, then select Disable Canon IJ
Network Scanner Selector EX.
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How to Restore the Machine's Network Settings to Factory Default

Important
Note that initialization erases all network settings on the machine, and printing, scanning, or faxing operation from a

computer over network may become impossible. To use the machine over network, setup with the Setup CD-ROM.

Select Reset LAN settings on the operation panel of the machine to initialize the network setting.
LAN settings
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Problems with Printing
 Printing Does Not Start
 Paper Jams
 Paper Does Not Feed Properly/"No Paper" Error Occurs
 Cannot Print on the Disc Label
 Cannot Print Properly with Automatic Duplex Printing
 Copying/Printing Stops Before It Is Completed
 Cannot Print Properly from a Wireless Communication Device
 Cannot Print from Picasa Web Albums (Cannot Access to Picasa Web Albums)
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Printing Does Not Start

• Check 1: Make sure that the power plug is securely plugged in, then turn the
machine on.
While any lamp on the operation panel is flashing, the machine is initializing. Wait until the lamp stops flashing and
remains lit.

Note
When printing large data such as a photo or graphics, it may take longer to start printing. While any lamp on the

operation panel is flashing, the computer is processing data and sending it to the machine. Wait until printing
starts.

• Check 2: Make sure that the machine is connected to your computer properly.
When the machine is connected to your computer with a USB cable, make sure that the USB cable is securely
plugged in to the machine and the computer, then check the followings:

• If you are using a relay device such as a USB hub, disconnect it, connect the machine directly to the computer,
and try printing again. If printing starts normally, there is a problem with the relay device. Consult the reseller of
the relay device for details.

• There could also be a problem with the USB cable. Replace the USB cable and try printing again.
When you use the machine over LAN, make sure that the machine is connected to the network with a LAN cable or is
set up correctly.

• Check 3: If you are printing from the computer and there are any unnecessary
print jobs, delete them.

Deleting the Undesired Print Job

• Check 4: Make sure that the inner cover (the cover of the disc tray) is closed.
If the inner cover is opened, close the inner cover and press the OK button on the machine.

• Check 5: Make sure that your machine's name is selected in the Print dialog box.
The machine will not print properly if you are using a printer driver for a different printer.
Make sure that your machine's name is selected in the Print dialog box.

Note
To make the machine the one selected by default, select Set as Default Printer.

• Check 6: Configure the printer port appropriately.
Make sure that the printer port is configured appropriately.

1. Log on as a user account with administrator privilege.

2. Select items from the Start menu as shown below.

• In Windows 7, select Devices and Printers from the Start menu.
• In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.
• In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware > Printers and

Faxes.

3. Open the properties of the printer driver for the machine.

• In Windows 7, right-click the "Canon XXX Printer" icon (where "XXX" is your machine's name), then select
Printer properties.

• In Windows Vista or Windows XP, right-click the "Canon XXX Printer" icon (where "XXX" is your
machine's name), then select Properties.
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4. Click the Ports tab to confirm the port settings.
Make sure that a port named "USBnnn" (where "n" is a number) with "Canon XXX Printer" appearing in the
Printer column is selected for Print to the following port(s).

Note
When the machine is used over LAN, the port name of the machine is displayed as

"CNBJNP_xxxxxxxxxx". "xxxxxxxxxx" is the character string generated from the MAC address or a character
string specified by the user when setting up the machine.

• If the setting is incorrect:
Reinstall the MP Drivers.

• Printing does not start even though the machine is connected to the computer using a USB cable and the
port named "USBnnn" is selected:
Click Start and select All programs, Canon Utilities, Canon My Printer, Canon My Printer, then select
Diagnose and Repair Printer. Follow the on-screen instructions to set the correct printer port, then select
your machine's name.
If the problem is not resolved, reinstall the MP Drivers.

• Printing does not start even though the port named "CNBJNP_xxxxxxxxxx" is selected when the machine
is used over LAN:
Launch IJ Network Tool, and select "CNBJNP_xxxxxxxxxx" as you confirmed in step 4, then associate the
port with the printer using Associate Port in the Settings menu.
If the problem is not resolved, reinstall the MP Drivers.

• Check 7: Is the size of the print data extremely large?
Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in the
displayed dialog to On.
* When On is selected for Prevention of Print Data Loss, print quality may be reduced.

• Check 8: Restart your computer if you are printing from the computer.
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Paper Jams
When paper is jammed, a troubleshooting message is displayed automatically. Take the appropriate action described in
the message.

• When a Support Code and a message are displayed on the computer screen:

• When a Support Code and a message are displayed on the LCD:

For details on how to remove the jammed paper, refer to Support Code List (When Paper Is Jammed).

Note
You can confirm the actions against errors with Support Codes on your computer or on the LCD by searching a

Support Code.
Click Here to Search

61



Paper Does Not Feed Properly/"No Paper" Error Occurs

• Check 1: Make sure that paper is loaded.
Loading Paper

• Check 2: Make sure of the following when you load paper.
• When loading two or more sheets of paper, flip through the paper before loading.

• When loading two or more sheets of paper, align the edges of the sheets before loading.
• When loading two or more sheets of paper, make sure that the paper stack does not exceed the paper load

limit.
However, proper feeding of paper may not be possible at this maximum capacity depending on the type of paper
or environmental conditions (either very high or low temperature and humidity). In such cases, reduce the sheets
of paper you load at a time to less than half of the paper load limit.

• Always load the paper in portrait orientation, regardless of the printing orientation.

Important
When loading paper in the cassette, slide the paper guide on the front side to align with the corresponding

mark of page size. Load the paper with the print side facing DOWN, load the paper stack in the center of the
cassette, then slide the paper guides to align with the both edges of the paper stack.

Loading Paper

• Check 3: Check to see if the paper you are printing on is not too thick or curled.
Media Types You Cannot Use

• Check 4: Make sure of the following when you load Hagakis or envelopes.
• If a Hagaki is curled, it may not feed properly even though the paper stack does not exceed the paper load limit.

Load Hagakis with a zip code column toward the far end of the cassette (upper).
• When printing on envelopes, refer to Loading Paper, and prepare the envelopes before printing.

Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are placed in
landscape orientation, they will not feed properly.

• Check 5: Confirm that the media type and the paper size settings correspond with
the loaded paper.

• Check 6: Make sure that the inner cover (the cover of the disc tray) is closed
completely.
Paper does not feed properly if the inner cover is even slightly open.

Placing a Printable Disc

• Check 7: Clean the paper feed roller.
Cleaning the Paper Feed Roller

Note
Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.

• Check 8: If two or more sheets of paper feed from the cassette at once, clean the
inside of the cassette.
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For information on cleaning the inside of the cassette, refer to Cleaning the Pad in the Cassette.

• Check 9: Are the transport unit cover and the rear cover attached properly?
Refer to Rear View for the position of the rear cover.
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Cannot Print on the Disc Label
Disc Label Printing Does Not Start
Disc Tray Does Not Feed Properly
Disc Tray Jammed

Disc Label Printing Does Not Start

• Check 1: Is the disc tray placed properly?
Open the inner cover (the cover of the disc tray), properly place the disc tray again, then press the OK button on the
machine to dismiss the error.
Use the disc tray supplied with this machine ("J" is on the upper side).
For details on how to place the disc tray, refer to Placing a Printable Disc.

• Check 2: Is the printable disc placed on the disc tray?
Place the printable disc on the disc tray properly, then press the OK button on the machine to dismiss the error.
Use the disc tray supplied with this machine ("J" is on the upper side).
For details on how to place the disc tray, refer to Placing a Printable Disc.

• Check 3: If disc label printing stops before it is complete, try the operation again.
If a certain period of time has elapsed while disc label printing is in progress, the machine stops initializing.
The machine resumes initializing by pressing the OK button.
Try the operation again following the on-screen instructions.

Disc Tray Does Not Feed Properly

• Check 1: Is the disc tray placed properly?
Open the inner cover, properly place the disc tray again, then press the OK button on the machine to dismiss the
error.
Make sure that you are using the disc tray supplied with the machine ("J" is on the upper side).
For details on how to place the disc tray, refer to Placing a Printable Disc.

• Check 2: Unrecognizable printable disc may be placed.
Canon recommends that you use printable discs specially processed to be printed on by an inkjet printer.

Disc Tray Jammed
Pull out the disc tray gently.
If the disc tray cannot be pulled out, turn the machine off, then turn the machine back on again. The disc tray will
automatically be ejected.
When the disc tray is pulled out, place the disc tray ("J" is on the upper side) again, then retry printing. Place the printable
disc properly referring to Placing a Printable Disc.
If the disc tray is still jammed, check if there is a problem with the printable disc.

Disc Tray Does Not Feed Properly
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Cannot Print Properly with Automatic Duplex Printing

• Check 1: Is the setting for automatic duplex printing selected?
Make sure that the Duplex Printing and Automatic check boxes are selected on the Page Setup sheet in the printer
driver setup window.

Duplex Printing

• Check 2: Make sure that the actual size of the paper is suitable for automatic
duplex printing.
The sizes of media suitable for automatic duplex printing are A4, Letter, A5, B5, and Hagaki.
Load paper of suitable size, then press the OK button on the machine.

• Check 3: Make sure that the paper size setting is correct.
Make sure that the paper size setting matches the actual size of the paper with a size suitable for automatic duplex
printing.
First, check the paper size setting in the application software you are printing from.
Then, check the Page Size setting on the Page Setup sheet in the printer driver setup window.

Note
Duplex printing may not be available depending on the version of the application software.

• Check 4: Make sure that the media type setting is correct.
Make sure that the media type setting matches the actual size of the paper with a size suitable for automatic duplex
printing.
Make sure that the type of loaded paper is suitable for automatic duplex printing on the Main sheet in the printer
driver setup window.

Note
To switch to manual duplex printing, follow the procedure below.

Open the printer driver setup window, clear the Automatic check box on the Page Setup sheet, and reprint.
When performing manual duplex printing, note the following.

If you are printing three or more pages of a document with manual duplex printing, one side of all sheets of
paper will be printed first. Turn over the paper and reload the paper in the machine, and then the reverse side of
all sheets of paper will be printed. Be careful not to change the order of paper in the stack.
The procedure for reversing the paper varies depending on the staple side and printing orientation. Follow the

on-screen instructions.
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Copying/Printing Stops Before It Is Completed

• Check 1: Is the inner cover (the cover of the disc tray) opened while printing on
paper?
Close the inner cover, then press the OK button on the machine.

• Check 2: Is the paper loaded?
Make sure that paper is loaded.
If the machine has run out of paper, load paper.

• Check 3: Do the printing documents have lots of photographs or illustrations?
As printing large data such as photos or graphics takes time for the machine and the computer to process, the
machine may appear to have stopped operating.
In addition, when printing data that uses a large amount of ink continuously on plain paper, the machine may pause
temporarily. In either case, wait until the process is complete.

Note
If you are printing a document with a large printing area or printing multiple copies of a document, printing may

pause to allow the ink to dry.

• Check 4: Has the machine been printing continuously for a long period?
If the machine has been printing continuously for a long time, the print head or other parts around it may overheat.
The machine may stop printing at a line break for a period of time and then resume printing.
In this case, wait for a while without operation. If the printing still does not resume, interrupt your print session at a
convenient time and turn the machine off for at least 15 minutes.

Caution
The print head and the surrounding area can become extremely hot inside the machine. Never touch the print

head or nearby components.
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Cannot Print Properly from a Wireless Communication Device

• Check: Is printing possible through Bluetooth communication?
Confirm that your mobile phone and the machine are connected via Bluetooth communication, then start printing
again.

Printing from Mobile Phone via Bluetooth Communication
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Problems with Printing Quality
 Print Results Not Satisfactory
 Ink Is Not Ejected
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Print Results Not Satisfactory
If the print result is not satisfactory due to white streaks, misaligned lines, or uneven colors, confirm the paper and print
quality settings first.

• Check 1: Do the page size and media type settings match the size and type of the
loaded paper?
When these settings are incorrect, you cannot obtain a proper print result.
If you are printing a photograph or an illustration, incorrect paper type settings may reduce the quality of the printout
color.
Also, if you print with an incorrect paper type setting, the printed surface may be scratched.
In borderless printing, uneven coloring may occur depending on the combination of the paper type setting and the
loaded paper.
The method of confirming the paper and print quality settings differs depending on what you do with your machine.

To copy by operating the machine Confirm by using the operation panel on the machine.
Setting Items

To copy photo by operating the machine Confirm by using the operation panel on the machine.
Copying Photos

To print from your USB flash drive by operating the machine Confirm by using the operation panel on the machine.
Setting Items

To print photo on an online photo album by operating the
machine

Confirm by using the operation panel on the machine.
Printing Photos in Online Photo Album

To print from a PictBridge compliant device

Confirm by using your PictBridge compliant device.
About PictBridge Print Settings

Confirm by using the operation panel on the machine.
PictBridge print settings

To print from a mobile phone Confirm by using the operation panel on the machine.
Mobile phone print settings

To print from a computer Confirm by using the printer driver.
Printing with Easy Setup

• Check 2: Make sure that the appropriate print quality is selected referring to the
table in Check 1.
Select a print quality option suitable for the paper and image for printing. If you notice blurs or uneven colors,
increase the print quality setting and try printing again.

Note
When printing from a PictBridge compliant device, set the print quality setting by using the operation panel on

the machine.
You cannot make this setting from a PictBridge compliant device.
You cannot change the print quality setting when printing from a mobile phone.

• Check 3: If the problem is not resolved, there may be other causes.
See also the sections below:

Cannot Print to End of Job
Part of the Page Is Not Printed
No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks
Lines Are Misaligned
Line Does Not Print or Prints Partially
Image Does Not Print or Prints Partially
Printed Paper Curls or Has Ink Blots
Paper Is Smudged/Printed Surface Is Scratched
Back of the Paper Is Smudged
Vertical Lines Are Printed on the Sides of the Printout
Colors Are Uneven or Streaked
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Cannot Print to End of Job

• Check 1: Select the setting not to compress the printing data.
If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.
Click Print Options on the Page Setup sheet on the printer driver. Select the Do not allow application software to
compress print data check box, then click OK.
* Deselect the check box after printing is complete.

• Check 2: Is the size of the print data extremely large?
Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in the
displayed dialog to On.
* When On is selected for Prevention of Print Data Loss, print quality may be reduced.

• Check 3: Is the space of your computer's hard disk sufficient?
Delete unnecessary files to free disk space.
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Part of the Page Is Not Printed

• Check: When performing automatic duplex printing, the reason below is possible.
When performing automatic duplex printing, the printable area at the top of the page will be 0.08 inches / 2 mm
narrower than the usual.
For this reason, the bottom of the page may not be printed. To prevent this, select the setting to reduce printing from
the printer driver.

Important
Reduced printing may affect the layout depending on your document.

Apply the print setting specified with the application software if the software has a enlarge/reduce printing
function.

1. Open the printer driver setup window.
How to Open the Printer Driver Setup Window

2. Check the Duplex Printing check box in the Page Setup sheet.

3. Click Print Area Setup..., then select Use reduced printing.
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No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks

 No Printing Results

 Printing Is Blurred

 Colors Are Wrong

 White Streaks
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• Check 1: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

• Check 2: Check the status of ink tanks. Replace the ink tank if the ink has run out.
Replacing an Ink Tank

• Check 3: Is the orange tape or protective film remaining?
Make sure that all of the protective film is peeled off and the Y-shape air hole is exposed, as illustrated in (A).
If the orange tape is left as in (B), pull the orange tape and remove it.

• Check 4: Print the Nozzle Check Pattern and perform any necessary maintenance
operations such as Print Head Cleaning.
Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.
Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:
Check to see if a particular color's ink tank is not empty.
If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head Cleaning and
try printing the Nozzle Check Pattern again.

• If the problem is not resolved after performing the Print Head Cleaning twice:
Perform the Print Head Deep Cleaning.
If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the machine and perform
another Print Head Deep Cleaning after 24 hours. When you turn the machine off, do not unplug it from the
power supply.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:
If Print Head Deep Cleaning does not resolve the problem, the print head may be damaged. Contact the service
center.

• Check 5: When using paper with one printable surface, make sure that the paper
is loaded with the printable side facing down.
Load paper with the printable side facing down.
Refer to the instruction manual supplied with the paper for detailed information on the printable side.

• When copying, see also the sections below:

• Check 6: Is the platen glass or the glass of ADF dirty?
Clean the platen glass or the glass of ADF.

Cleaning the Platen Glass and Document Cover

Note
If the glass of ADF is dirty, black streaks appear on the paper as shown below.

73



• Check 7: Check that the original is loaded correctly on the platen glass or in the
ADF.

Loading Originals

• Check 8: Is the original document is loaded with the proper side facing up/down?
When loading the original on the platen glass, the side to be copied should be face down. When loading the original
in the ADF, the side to be copied should be face up.

• Check 9: Did you copy a printout done by this machine?
If you use a printout done by this machine as the original, print quality may be reduced depending on the condition of
the original.
Print from the machine directly, or reprint from the computer.
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Lines Are Misaligned

• Check 1: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

• Check 2: Perform Print Head Alignment.
If printed lines are misaligned or print results are otherwise unsatisfactory, adjust the print head position.

Aligning the Print Head

Note
If the problem is not resolved after performing the Print Head Alignment, perform Print Head Alignment

manually referring to Aligning the Print Head Manually.

• Check 3: Increase the print quality and try printing again.
Increasing the print quality on the operation panel of the machine or in the printer driver may improve the print result.
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Line Does Not Print or Prints Partially

• Check 1: Is the Page Layout Printing performed or the Binding margin function
used?
When the Page Layout Printing or Binding margin function is being used, thin lines may not be printed. Try thickening
the lines in the document.

• Check 2: Is the size of the print data extremely large?
Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in the
displayed dialog to On.
* When On is selected for Prevention of Print Data Loss, print quality may be reduced.
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Image Does Not Print or Prints Partially

• Check 1: Select the setting not to compress the printing data.
If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.
Click Print Options on the Page Setup sheet on the printer driver. Select the Do not allow application software to
compress print data check box, then click OK.
* Deselect the check box after printing is complete.

• Check 2: Is the size of the print data extremely large?
Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in the
displayed dialog to On.
* When On is selected for Prevention of Print Data Loss, print quality may be reduced.
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Printed Paper Curls or Has Ink Blots

 Printed Paper Has Ink Blots

 Printed Paper Curls

• Check 1: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

• Check 2: If the intensity is set high, reduce the intensity setting and try printing
again.
If you are using plain paper to print images with high intensity, the paper may absorb too much ink and become wavy,
causing paper abrasion.

• When printing from your computer
You can confirm the intensity using the printer driver.

Adjusting Intensity

• When copying
Setting Items

• Check 3: Is Photo Paper used for printing photographs?
When printing data with high color saturation such as photographs or images in deep color, we recommend using
Photo Paper Plus Glossy II or other Canon speciality paper.

Media Types You Can Use
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Paper Is Smudged/Printed Surface Is Scratched

 Paper Is Smudged

The Edges of Paper Are Smudged Printed Surface Is Smudged

 Printed Surface Is Scratched

• Check 1: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

• Check 2: Is the appropriate type of paper used? Check the followings:
• Check to see if the paper you are printing on is suitable for your printing purpose.

Media Types You Can Use
• When performing Borderless Printing, make sure that the paper you are using is suitable for Borderless Printing.

If the paper you are using is not suitable for Borderless Printing, the print quality may be reduced at the top and
bottom edges of the paper.

Printing Area

• Check 3: Load the paper after correcting its curl.
When using Photo Paper Plus Semi-gloss, even if the sheet is curled, load one sheet at a time as it is. If you roll up
this paper to flatten, this may cause cracks on the surface of the paper and reduce the print quality.
We recommend putting unused paper back into the package and keeping it on a level surface.

• For Plain Paper
Turn the paper over and reload it to print on the other side.

• For Other Paper
If the curl on the four corners of the paper is more than 0.1 inch / 3 mm (A) in height, the paper may be smudged
or may not be fed properly. In such cases, follow the procedure described below to correct the paper curl.

1. Roll up the paper in the opposite direction to the paper curl as shown below.
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2. Check that the paper is now flat.
We recommend printing curl-corrected paper one sheet at a time.

Note
Depending on the media type, the paper may be smudged or may not be fed properly even if it is not curled

inward. In such cases, follow the procedure described below to curl the paper outward within 0.1 inch / 3 mm (B)
in height before printing. This may improve the print result.

(C) Printing side
We recommend printing paper that has been curled outward one sheet at a time.

• Check 4: Adjust the setting to prevent paper abrasion.
Adjusting the setting to prevent paper abrasion will widen the clearance between the print head and the loaded
paper. If you notice abrasion even with the media type set correctly to match the loaded paper, set the machine to
prevent paper abrasion by using the operation panel or the computer.
Print speed may be reduced if you apply the setting to prevent paper abrasion setting.
* Readjust the setting not to prevent paper abrasion once printing is complete. If not, this setting remains enabled for
all subsequent print jobs.

• To set by using the operation panel
Press the MENU button, then select Setup, Device settings, and Print settings in this order, then set Prevent
paper abrasion to ON.

Changing the Machine Settings on the LCD

• To set by using your computer
Open the printer driver setup window, and in Custom Settings in the Maintenance sheet, select the Prevent
paper abrasion check box, and then click OK.
To open the printer driver setup window, see How to Open the Printer Driver Setup Window.

• Check 5: If the intensity is set high, reduce the intensity setting and try printing
again.
If you are using plain paper to print images with high intensity, the paper may absorb too much ink and become wavy,
causing paper abrasion.

• When printing from your computer
Reduce the intensity setting in the printer driver and try printing again.

1. Open the printer driver setup window.
How to Open the Printer Driver Setup Window

2. On the Main sheet, select Manual for Color/Intensity, and then click Set....

3. Drag the Intensity slide bar on the Color Adjustment sheet to adjust the intensity.
• When copying
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Setting Items

• Check 6: Is printing performed beyond the recommended printing area?
If you are printing beyond the recommended printing area of your printing paper, the lower edge of the paper may
become stained with ink.
Resize your original document in your application software.

Printing Area

• Check 7: Is the platen glass or the glass of ADF dirty?
Clean the platen glass or the glass of ADF.

Cleaning the Platen Glass and Document Cover

Note
If the glass of ADF is dirty, black streaks appear on the paper as shown below.

• Check 8: Is the paper feed roller dirty?
Clean the paper feed roller.

Cleaning the Paper Feed Roller

Note
Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.

• Check 9: Is the inside of the machine dirty?
When performing duplex printing, the inside of the machine may become stained with ink, causing the printout to
become smudged.
Perform the Bottom Plate Cleaning to clean the inside of the machine.

Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Note
To prevent the inside of the machine from stains, set the paper size correctly.

• Check 10: Set the time to dry the printed surface longer.
Doing so gives the printed surface enough time to dry so that paper smudged and scratched are prevented.

1. Make sure that the machine is turned on.

2. Open the printer driver setup window.
How to Open the Printer Driver Setup Window

3. Click the Maintenance tab and then Custom Settings.

4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click OK.

5. Confirm the message and click OK.
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Back of the Paper Is Smudged

• Check 1: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

• Check 2: Is the paper feed roller dirty?
Clean the paper feed roller.

Cleaning the Paper Feed Roller

Note
Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.

• Check 3: Perform the Bottom Plate Cleaning to clean the inside of the machine.
Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Note
When performing borderless printing, duplex printing, or too much printing, the inside may become stained with

ink.
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Vertical Lines Are Printed on the Sides of the Printout

• Check: Is the size of the loaded paper correct?
The vertical lines may be printed in the margin if the size of the loaded paper is larger than that you have specified.
Set the paper size correctly according to the paper you loaded.

Print Results Not Satisfactory

Note
The direction of the vertical line pattern may vary depending on the image data or the print setting.
This machine performs automatic cleaning when necessary to keep printouts clean. A small amount of ink is

ejected for cleaning.
Although ink is usually ejected on the ink absorber, it may be ejected on the paper if you load paper larger than
that you have specified.
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Colors Are Uneven or Streaked

 Colors Are Uneven

 Colors Are Streaked

• Check 1: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

• Check 2: Print the Nozzle Check Pattern and perform any necessary maintenance
operations such as Print Head Cleaning.
Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.
Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:
Check to see if a particular color's ink tank is not empty.
If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head Cleaning and
try printing the Nozzle Check Pattern again.

• If the problem is not resolved after performing the Print Head Cleaning twice:
Perform the Print Head Deep Cleaning.
If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the machine and perform
another Print Head Deep Cleaning after 24 hours. When you turn the machine off, do not unplug it from the
power supply.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:
If Print Head Deep Cleaning does not resolve the problem, the print head may be damaged. Contact the service
center.

• Check 3: Perform Print Head Alignment.
Aligning the Print Head
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Note
If the problem is not resolved after performing the Print Head Alignment, perform Print Head Alignment

manually referring to Aligning the Print Head Manually.
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Ink Is Not Ejected

• Check 1: Has the ink run out?
Check the Support Code on the LCD and take the appropriate action to resolve the error.

Support Code List

• Check 2: Is the orange tape or protective film remaining?
Make sure that all of the protective film is peeled off and the Y-shape air hole is exposed, as illustrated in (A).
If the orange tape is left as in (B), pull the orange tape and remove it.

• Check 3: Are the print head nozzles clogged?
Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.
Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:
Check to see if a particular color's ink tank is not empty.
If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head Cleaning and
try printing the Nozzle Check Pattern again.

• If the problem is not resolved after performing the Print Head Cleaning twice:
Perform the Print Head Deep Cleaning.
If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the machine and perform
another Print Head Deep Cleaning after 24 hours. When you turn the machine off, do not unplug it from the
power supply.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:
If Print Head Deep Cleaning does not resolve the problem, the print head may be damaged. Contact the service
center.
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Problems with Scanning
 Problems with Scanning
 Scan Results Not Satisfactory
 Software Problems
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Problems with Scanning
Scanner Does Not Work
ScanGear (Scanner Driver) Does Not Start
Error Message Appears and the ScanGear (Scanner Driver) Screen Does Not Appear
Cannot Scan Multiple Items at One Time
Cannot Scan Properly with Auto Scan
Slow Scanning Speed
"There is not enough memory." Message Is Displayed
Computer Stops Operating during Scanning
Scanner Does Not Work after Upgrading Windows
Scanned Image Does Not Open
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Scanner Does Not Work

Check 1: Make sure that your scanner or printer is turned on.

Check 2: Connect the USB cable to a different USB port on the computer.

Check 3: If the USB cable is connected to a USB hub, remove it from the USB hub
and connect it to a USB port on the computer.

Check 4: Restart the computer.
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ScanGear (Scanner Driver) Does Not Start

Check 1: Make sure that MP Drivers is installed.
If not installed, install MP Drivers using the Setup CD-ROM.

Check 2: Select your scanner or printer on the application's menu.

Important
If your scanner or printer name is displayed multiple times, select the one that does not include WIA.

Note
The operation may differ depending on the application.
Use the WIA driver when scanning from a WIA-compliant application.

Scanning with WIA Driver

Check 3: Make sure that the application is TWAIN-compliant.
You cannot open ScanGear (scanner driver) from applications not supporting TWAIN.

Check 4: Scan and save images with IJ Scan Utility and open the files in your
application.
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Error Message Appears and the ScanGear (Scanner Driver) Screen Does
Not Appear

Check 1: Make sure that your scanner or printer is turned on.

Check 2: Turn off your scanner or printer, then reconnect the USB cable and replug
the power cord.

Check 3: Connect the USB cable to a different USB port on the computer.

Check 4: If the USB cable is connected to a USB hub, remove it from the USB hub
and connect it to a USB port on the computer.

Check 5: Make sure that MP Drivers is installed.
If not installed, install MP Drivers using the Setup CD-ROM.

Check 6: Select your scanner or printer on the application's menu.

Note
The operation may differ depending on the application.

Check 7: Make sure that the application is TWAIN-compliant.
You cannot open ScanGear (scanner driver) from applications not supporting TWAIN.

Check 8: Exit ScanGear if it is running on another application.
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Cannot Scan Multiple Items at One Time

Check 1: Make sure that the items are placed correctly.
Placing Items (When Scanning from a Computer)

Check 2: Check if you can properly scan one item.
Some applications do not support multiple image scanning. In that case, scan each item individually.

92



Cannot Scan Properly with Auto Scan

Check 1: Make sure that the items are placed correctly.
Placing Items (When Scanning from a Computer)

Check 2: Multiple items scanning may not be supported.
Some applications do not support multiple image scanning. In that case, scan each item individually.
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Slow Scanning Speed

Check 1: To view the image on a monitor, set the output resolution to around 150 dpi.
To print, set it to around 300 dpi.

Resolution

Check 2: Set Fading Correction, Grain Correction, etc. to None.
Refer to "Image Settings" for your model from Home of the Online Manual for details.

Check 3: In IJ Scan Utility, deselect the Correct slanted text document / Detect the
orientation of text document and rotate image checkbox and scan again.

Settings (Document Scan) Dialog Box
Settings (Custom Scan) Dialog Box
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"There is not enough memory." Message Is Displayed

Check 1: Exit other applications and try again.

Check 2: Reduce the resolution or output size and scan again.
Resolution
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Computer Stops Operating during Scanning

Check 1: Restart the computer, reduce the output resolution in ScanGear (scanner
driver) and scan again.
Refer to "Output Settings" for your model from Home of the Online Manual for details.

Check 2: Delete unnecessary files to obtain sufficient free hard disk space, then scan
again.
Error message may appear if there is not enough hard disk space to scan and save, when the image size is too large
(such as when scanning a large item at high resolution).

Check 3: In Folder to Save Temporary Files of IJ Scan Utility, specify a folder on a
drive with sufficient free space.

Settings (General Settings) Dialog Box

Check 4: Multiple devices may be connected to USB ports.
Disconnect devices other than your scanner or printer.
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Scanner Does Not Work after Upgrading Windows

Check: Disconnect the USB cable, then uninstall (delete) and reinstall MP Drivers and
IJ Scan Utility.

• Step 1: Uninstall MP Drivers.
See "Deleting the Unnecessary MP Drivers" for your model from Home of the Online Manual for how to delete MP
Drivers.

• Step 2: Uninstall IJ Scan Utility.

• Windows 7 / Windows Vista:

1. From the Start menu, select Control Panel > Programs > Uninstall a program.

2. Double-click Canon IJ Scan Utility.

3. When a confirmation appears, click Yes.

4. When uninstallation is complete, click OK.

IJ Scan Utility is deleted.

Note
In Windows 7 and Windows Vista, a confirmation/warning dialog box may appear when installing,

uninstalling, or starting up software.
This dialog box appears when administrative rights are required to perform a task.
If you are logged on to an administrator account, follow the on-screen instructions.

• Windows XP:

1. From the Start menu, select Control Panel > Add or Remove Programs.

2. Select Canon IJ Scan Utility, then click Remove.

3. When a confirmation appears, click Yes.

4. When uninstallation is complete, click OK.

IJ Scan Utility is deleted.

• Step 3: Reinstall MP Drivers and IJ Scan Utility.
Reinstall MP Drivers and IJ Scan Utility using the Setup CD-ROM.
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Scanned Image Does Not Open

Check: If the data format is not supported by the application, scan the image again
and select a popular data format such as JPEG when saving it.
For details, see the application's manual. If you have any questions, contact the manufacturer of the application.
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Scan Results Not Satisfactory
Scan Quality (Image Displayed on the Monitor) Is Poor
Scanned Image Is Surrounded by Extra White Areas
Cannot Scan at the Correct Size
Position or Size of the Image Cannot be Detected Correctly When Scanning from the Operation Panel
Item Is Placed Correctly, but the Scanned Image Is Slanted
Scanned Image Is Enlarged (Reduced) on the Computer Monitor
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Scan Quality (Image Displayed on the Monitor) Is Poor

Check 1: Increase the scanning resolution if the image is jagged.
Resolution

Check 2: Set the display size to 100 %.
Some applications do not display images clearly if the display size is too small.

Check 3: If moire (stripe pattern) appears, take the following measures and scan
again.

• Set one of the following settings in the Settings (Document Scan) dialog box of IJ Scan Utility, then click Document
in the IJ Scan Utility main screen.
- Set Select Source to Magazine and set Color Mode to Color
- Select the Reduce moire checkbox in Image Processing Settings

Settings (Document Scan) Dialog Box

• Set one of the following settings in the Settings (Custom Scan) dialog box of IJ Scan Utility, then click Custom in
the IJ Scan Utility main screen.
- Set Select Source to Magazine and set Color Mode to Color
- Select the Reduce moire checkbox in Image Processing Settings

Settings (Custom Scan) Dialog Box

• Set one of the following settings in the Settings (Scan and Stitch) dialog box of IJ Scan Utility, then click Stitch in
the IJ Scan Utility main screen.
- Set Select Source to Magazine and set Color Mode to Color
- Select the Reduce moire checkbox in Image Processing Settings

Settings (Scan and Stitch) Dialog Box

• On the Basic Mode tab of ScanGear (scanner driver), select Magazine (Color) in Select Source.
Refer to "Basic Mode Tab" for your model from Home of the Online Manual for details.

• On the Advanced Mode tab of ScanGear, set Descreen in Image Settings to ON.
Refer to "Image Settings" for your model from Home of the Online Manual for details.

Note
If moire appears when you scan a digital print photo, take the above measures and scan again.

Check 4: Check the monitor's color depth.
• Windows 7:

From the Start menu, select Control Panel > Appearance and Personalization > Display > Adjust screen
resolution > Advanced settings.
On the Monitor tab of the displayed dialog box, set Colors to High Color (16 bit) or True Color (32 bit).

• Windows Vista:
From the Start menu, select Control Panel > Appearance and Personalization > Adjust screen resolution to
display the Display Settings dialog box, then set Colors to Medium (16 bit) or Highest (32 bit).

• Windows XP:
From the Start menu, select Control Panel > Appearance and Themes > Display to display the Display
Properties dialog box, then set Color quality to Medium (16 bit) or Highest (32 bit) on the Settings tab.

Check 5: Clean the platen and document cover.

Check 6: If the document is in poor condition (dirty, faded, etc.), use Reduce Dust
and Scratches, Fading Correction, Grain Correction, etc. in Image Settings on the
Advanced Mode tab of ScanGear.
Refer to "Image Settings" for your model from Home of the Online Manual for details.

Check 7: If the color tone of images is different from the original document, take the
following measures and scan again.

• On the Advanced Mode tab of ScanGear, set Image Adjustment in Image Settings to None.
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Refer to "Image Settings" for your model from Home of the Online Manual for details.

• On the Color Settings tab in the Preferences dialog box of ScanGear, set Color Matching.
Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.
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Scanned Image Is Surrounded by Extra White Areas

Check: Specify the scan area.

Click  (Auto Crop) in whole image view of ScanGear (scanner driver) to automatically display the cropping frame
(scan area) according to the item size.
You can also manually specify the scan area in thumbnail view or when there are white margins along the item (for
example, in photos), or when you want to create custom cropping frames.

Adjusting Cropping Frames (IJ Scan Utility)
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Cannot Scan at the Correct Size

Check: Make sure that the items are placed correctly.
Placing Items (When Scanning from a Computer)
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Position or Size of the Image Cannot be Detected Correctly When
Scanning from the Operation Panel

Check 1: Make sure that the items are placed correctly.
Placing Items (When Scanning from a Computer)

Check 2: Check that the settings match the item to be scanned.
If you cannot scan properly by automatically detecting the item type, specify the item type and size.

• When Scanning from the Operation Panel
Refer to "Setting Items on the Operation Panel of the Machine" for your model from Home of the Online Manual for
details on the setting items when scanning from the operation panel.

• When Scanning with IJ Scan Utility
Scanning Photos
Scanning Documents
Scanning with Favorite Settings
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Item Is Placed Correctly, but the Scanned Image Is Slanted

Check: When Document or Magazine is selected for the item type, deselect the
Correct slanted text document checkbox and scan the item again.

Settings (Document Scan) Dialog Box
Settings (Custom Scan) Dialog Box
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Scanned Image Is Enlarged (Reduced) on the Computer Monitor

Check 1: Change the display setting in the application.
For details, see the application's manual. If you have any questions, contact the manufacturer of the application.

Note
You cannot reduce the image size in Paint. To reduce the display size, open the images in an application.

Check 2: Change the resolution setting in ScanGear (scanner driver) and scan again.
The higher the resolution, the larger the resulting image will be.

Resolution
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Software Problems
The E-mail Client You Want to Use Does Not Appear in the Screen for Selecting an E-mail Client
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The E-mail Client You Want to Use Does Not Appear in the Screen for
Selecting an E-mail Client

Check: Check that the e-mail client's MAPI is enabled.
See the e-mail client's manual for how to set MAPI.
If the problem is not solved even when MAPI is enabled, select None (Attach Manually) in the screen for selecting an e-
mail client, then manually attach the image to the outgoing e-mail.
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Problems with Faxing
 Problems Sending Faxes
 Problems Receiving Faxes
 Cannot Send a Fax Clearly
 Telephone Problems
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Problems Sending Faxes
Cannot Send a Fax
Cannot Perform Sequential Broadcasting by Redialing, or Cannot Dial Using the Numeric Buttons
Errors Often Occur When You Send a Fax

Cannot Send a Fax

• Check 1: Is the power turned on?
• You cannot send faxes if the power is turned off. Press the ON button to turn the power on.
• If you disconnected the power cord without turning off the power (one of the buttons on the operation panel is

lit), reconnecting it turns on the power automatically.
• If you disconnected the power cord after pressing the ON button to turn off the power (no buttons on the

operation panel are lit), reconnect it, then press the ON button to turn on the power.
• If the power was turned off due to power failure, etc., the power is automatically turned on when the power

failure is resolved.

Important
Confirm that all lamps on the operation panel are off before unplugging the power cord, then unplug the power

cord.
If a power failure occurs or you unplug the power cord, all faxes stored in the machine's memory are deleted.
For details on how to unplug the power cord, refer to Notice for Unplugging the Power Cord.

Note
If the faxes stored in the machine's memory are deleted by a power failure or unplugging the power cord, the list

of the faxes deleted from the machine's memory (MEMORY CLEAR REPORT) will be printed after turning the
machine on.
For details, see Summary of Reports and Lists.

• Check 2: Is the document being sent from memory or the fax being received into memory?
When the message for the transmission/reception is displayed on the LCD, a fax is being sent from/received into
machine's memory. Wait until the transmission/reception is complete.

• Check 3: Is the machine's memory full?
Delete contents in memory, then send a fax again.

Document Stored in Machine's Memory

• Check 4: Is the telephone line type set correctly?
Check the telephone line type setting and change it as necessary.

Setting the Telephone Line Type

• Check 5: Is Hook key setting set to Disable?
When you send a fax manually, dial the number with Enable selected for Hook key setting in Security control
under FAX settings, or dial the number using the telephone connected to the machine.

Security control

• Check 6: Is Dial tone detect set to ON?
Resend the fax after a while.
If you still cannot send the fax, select OFF for Dial tone detect in Advanced FAX settings under FAX settings.

Advanced FAX settings

• Check 7: Is the fax number registered correctly for speed dialing?
Check the recipient's fax/telephone number, correct the fax/telephone number registered to the speed dial code, then
send the document again.

Changing Registered Information

Note
You can check the information for speed dialing by printing CODED SPEED DIAL TELEPHONE NO. LIST.

Summary of Reports and Lists
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• Check 8: Does an error occur during transmission?
• Ensure that a message is displayed on the LCD. When a message is displayed on the LCD, check the cause.

A Message for Faxing Is Displayed on the LCD
• Print ACTIVITY REPORT and check for an error.

Summary of Reports and Lists

• Check 9: Is the document loaded properly?
Remove the document, then reload it on the platen glass or in the ADF.

Loading Originals

• Check 10: Does a printer error occur?
Ensure that an error message is displayed on the LCD. When an error message is displayed on the LCD, check the
cause.
When the error message with the support code is displayed, refer to Support Code List.
When the error message without the support code is displayed, refer to A Message Is Displayed.
If you are in a hurry, press the Stop button to close the message, then send the fax.

• Check 11: Is the telephone line connected correctly?
Reconnect the telephone line cable to the telephone line jack.

Basic Connection
If the telephone line is connected correctly, there is a problem with your telephone line. Contact your telephone
company and the manufacturer of your terminal adapter or telephone adapter.

Cannot Perform Sequential Broadcasting by Redialing, or Cannot Dial Using the Numeric
Buttons

• Check: Have you already selected the recipient from the redial history, or already dialed a number
by using the Numeric buttons?
You can dial one recipient by selecting from the redial history or by using the Numeric buttons as the recipient of
sequential broadcasting.
If you already have dialed by selecting from the redial history or by using the Numeric button, select the recipient from
the coded speed dial.

Errors Often Occur When You Send a Fax

• Check: Check the telephone line condition or the connection.
If the telephone line or connection is poor, reducing the transmission start speed may correct the error.
Reduce the transmission start speed on TX start speed in Adv. communication settings in Advanced FAX
settings under FAX settings.

Advanced FAX settings
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Problems Receiving Faxes
Cannot Receive a Fax, Cannot Print a Fax
Machine Does Not Switch Automatically between Voice and Fax Calls
Quality of Received Fax is Poor
Cannot Receive a Color Fax
Errors Often Occur When You Receive a Fax

Cannot Receive a Fax, Cannot Print a Fax

• Check 1: Is the power turned on?
• You cannot receive faxes if the power is turned off. Press the ON button to turn the power on.
• If you disconnected the power cord without turning off the power (one of the buttons on the operation panel is

lit), reconnecting it turns on the power automatically.
• If you disconnected the power cord after pressing the ON button to turn off the power (no buttons on the

operation panel are lit), reconnect it, then press the ON button to turn on the power.
• If the power was turned off due to power failure, etc., the power is automatically turned on when the power

failure is resolved.

Important
Confirm that all lamps on the operation panel are off before unplugging the power cord, then unplug the power

cord.
If a power failure occurs or you unplug the power cord, all faxes stored in the machine's memory are deleted.
For details on how to unplug the power cord, refer to Notice for Unplugging the Power Cord.

Note
If the faxes stored in the machine's memory are deleted by a power failure or unplugging the power cord, the list

of the faxes deleted from the machine's memory (MEMORY CLEAR REPORT) will be printed after turning the
machine on.
For details, see Summary of Reports and Lists.

• Check 2: Is the machine's memory full?
Print the received faxes stored in the machine's memory or save them on the USB flash drive, delete them from the
machine's memory, and have the sender resend the faxes.

Document Stored in Machine's Memory

• Check 3: Does an error occur during reception?
• Ensure that a message is displayed on the LCD. When a message is displayed on the LCD, check the cause.

A Message for Faxing Is Displayed on the LCD
• Print ACTIVITY REPORT and check for an error.

Summary of Reports and Lists

• Check 4: Is the telephone line cable connected to the external device jack?
Reconnect it to the telephone line jack.

Basic Connection

• Check 5: Is a different size of paper from that specified by Page size loaded?
If a different size of paper from that specified by Page size is loaded for printing faxes, the received faxes will not be
printed and will be stored in the machine's memory (Memory Reception). Load the same size of paper as that
specified by Page size, then press the OK button on the machine.

• Check 6: Is paper loaded?
If paper is not loaded, received faxes will be stored in the machine's memory without being printed (Memory
Reception). Load paper, then press the OK button.

• Check 7: Is the amount of remaining ink sufficient to print a fax?
If the amount of remaining ink is insufficient to print, received faxes will be stored in the machine's memory without
being printed (Memory Reception). Replace the ink tank, then print the faxes in the machine's memory.

Document Stored in Machine's Memory
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Note
If the machine was receiving faxes in the fax mode, printing will start automatically after the ink tank is replaced.

Replacing an Ink Tank
When the machine receives black & white faxes in the machine's memory, if 2-sided is selected for 2-

sidedPrintSetting in FAX paper settings in the Fax menu, selecting 1-sided may print the faxes.
You can set the machine to forcibly print a received fax even if the ink has run out.

Set Print when out of ink in Auto print settings under FAX settings to Print.
However, part or all of the fax may not be printed since the ink has run out.
Also, the contents of the fax will not be stored in the machine's memory.
If the ink has already run out, we recommend that Do not print be selected for Received documents in Auto
print settings under FAX settings to store the received fax in the machine's memory. After you replace the ink
tank and select Print for Received documents in Auto print settings, the fax stored in the machine's memory
will be printed automatically.

Auto print settings

• Check 8: Is the machine set to the appropriate receive mode?
Check the receive mode setting and change it to a mode suited to your connection if necessary.

Setting the Receive Mode

• Check 9: Is FAX reception reject set to ON?
Select OFF for FAX reception reject in Security control under FAX settings.
For details on how to set, see Rejecting Fax Reception.

• Check 10: Are there setting items set Reject in Caller rejection?
If you select Reject for any setting items in Caller rejection in Security control under FAX settings, the machine
rejects calls for setting item selected Reject.
For details on how to set, see Using the Caller ID Service to Reject Calls.

Machine Does Not Switch Automatically between Voice and Fax Calls

• Check: Is the receive mode set to FAX only mode?
If FAX only mode is selected for Receive mode settings, there will be no automatic switching between voice and
fax calls.
Set the receive mode to TEL priority mode, DRPD*1, or Network switch*2.
If the receive mode is TEL priority mode and an answering machine is connected to the machine, check whether a
proper message is played back when the answering machine answers.

Setting the Receive Mode
*1 This setting is available only in the US and Canada.
*2 This setting may not be available depending on the country or region of purchase.

Quality of Received Fax is Poor

• Check 1: Check the scan settings of the sender's fax machine.
Ask the sender to adjust the scan settings of the fax machine.

• Check 2: Is ECM RX set to OFF?
Select ON for ECM RX in Adv. communication settings in Advanced FAX settings under FAX settings.
If ECM RX is enabled, the sender's fax machine resends the fax after correcting errors automatically.

Advanced FAX settings

• Check 3: Is the sender's original document or scanning area of the sender's fax machine dirty?
The image quality of the fax is mainly determined by the sender's fax machine. Contact the sender and ask the
sender to check whether the scanning area of the fax machine is dirty.

• Check 4: Is ECM transmission/reception enabled although the line/connection is poor, or is the
sender's fax machine compatible with ECM?

• Select ON for ECM RX in Adv. communication settings in Advanced FAX settings under FAX settings.
Advanced FAX settings
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• Contact the sender and ask the sender to check whether the machine is set to enable ECM transmission.
If the sender's or recipient's fax machine is not compatible with ECM, the fax will be sent/received without
automatic error correction.

• Reduce the reception start speed on RX start speed in Adv. communication settings in Advanced FAX
settings under FAX settings.

Advanced FAX settings

• Check 5: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

Cannot Receive a Color Fax

• Check: Is ECM RX set to OFF?
If OFF is select for ECM RX in Adv. communication settings in Advanced FAX settings under FAX settings, the
machine cannot receive color faxes. The machine will disconnect the telephone line or receive color faxes in black &
white according to the setting of the sender's fax machine.
Set ECM RX to ON.

Advanced FAX settings

Errors Often Occur When You Receive a Fax

• Check 1: Check the telephone line condition or the connection.
If the telephone line or connection is poor, reducing the reception start speed may correct the error.
Reduce the reception start speed on RX start speed in Adv. communication settings in Advanced FAX settings
under FAX settings.

Advanced FAX settings

• Check 2: Is the sender's fax machine operating normally?
Contact the sender and ask the sender to check whether the fax machine is operating normally.

114



Cannot Send a Fax Clearly

• Check 1: Is the document loaded correctly?
Remove the document, then reload it on the platen glass or in the ADF.

Loading Originals

• Check 2: Is the platen glass and/or the inner side of the document cover and/or
the glass of ADF dirty?
Clean the platen glass and/or the inner side of the document cover and/or the glass of ADF, then reload the
document.

Cleaning the Platen Glass and Document Cover

Note
If the glass of ADF is dirty, black streaks appear on the paper as shown below.

• Check 3: Is the image quality setting or the scan contrast setting suitable for the
document?
On the LCD, select an image quality setting and a scan contrast setting that are suitable for the document.

Sending Faxes with the Numeric Buttons

• Check 4: Is the original document loaded with the wrong side facing upwards or
downwards?
When loading a document on the platen glass, the side to be scanned should be face down.
When loading a document in the ADF, the side to be scanned should be face up.

• Check 5: Are you scanning thick or curled documents?
Thick or curled documents may not be sent as good quality faxes, because of a shadow or distortion caused when
such documents are scanned.
When loading a document on the platen glass, press on the document cover with your hand when scanning.
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Telephone Problems
Cannot Dial
Telephone Disconnects During a Call

Cannot Dial

• Check 1: Is the telephone line cable connected correctly?
Check that the telephone line cable is connected correctly.

Basic Connection

• Check 2: Is the telephone line type of the machine or the external device set correctly?
Check the telephone line type setting and change it as necessary.

Setting the Telephone Line Type

Telephone Disconnects During a Call

• Check: Is the telephone line cable or the telephone (or a peripheral device such as an external
telephone, an answering machine, or a computer modem) connected correctly?
Check that the telephone line cable and the telephone (or a peripheral device such as an external telephone, an
answering machine, or a computer modem) are connected correctly.

Connecting the Telephone Line
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Problems with the Machine
 The Machine Cannot Be Powered On
 Cannot Connect to Computer with a USB Cable Properly
 Cannot Communicate with the Machine with USB Connection
 LCD Cannot Be Seen At All
 An Unintended Language Is Displayed on the LCD
 Print Head Holder Does Not Move to the Position for Replacing
 Printer Status Monitor Is Not Displayed
 If the Output Tray Extension Comes Off
 Problems with Bluetooth Communication
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The Machine Cannot Be Powered On

• Check 1: Press the ON button.

• Check 2: Make sure that the power plug is securely plugged into the power cord
connector of the machine, then turn it back on.

• Check 3: Unplug the machine from the power supply, then plug the machine back
in and turn the machine back on after leaving it for at least 3 minutes.
If the problem is not resolved, contact the service center.
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Cannot Connect to Computer with a USB Cable Properly

Printing or Scanning Speed Is Slow/Hi-Speed USB Connection Does Not Work/"This device
can perform faster" Message Is Displayed
If your system environment is not fully compatible with Hi-Speed USB, the machine will operate at a lower speed provided
under USB 1.1. In this case, the machine operates properly but printing or scanning speed may slow down due to
communication speed.

• Check: Check the following to make sure that your system environment supports Hi-Speed USB
connection.

• Does the USB port on your computer support Hi-Speed USB connection?
• Does the USB cable or the USB hub support Hi-Speed USB connection?

Be sure to use a certified Hi-Speed USB cable. We recommend that the cable is no longer than around 10 feet /
3 meters.

• Does the operating system of your computer support Hi-Speed USB connection?
Obtain and install the latest update for your computer.

• Does the Hi-Speed USB driver operate properly?
Obtain the latest version of the Hi-Speed USB driver compatible with your hardware and reinstall it on your
computer.

Important
For details on Hi-Speed USB of your system environment, contact the manufacturer of your computer, USB

cable, or USB hub.
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Cannot Communicate with the Machine with USB Connection

• Check 1: Make sure that the machine is turned on.

• Check 2: Make sure that the USB cable is connected properly.
See Connecting the Machine to the Computer Using a USB Cable to connect the USB cable properly.

• Check 3: Do not start up IJ Network Tool while printing.

• Check 4: Do not print while IJ Network Tool is running.

• Check 5: Make sure that Enable bidirectional support is selected in the Ports
sheet of the properties dialog box of the printer driver.

How to Open the Printer Driver Setup Window
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LCD Cannot Be Seen At All

• If all the lamps on the operation panel are off:
The machine is not powered on. Connect the power cord and press the ON button.

• If any lamp on the operation panel is lit:
The LCD may be in the screen-saver mode. Press one of the buttons on the operation panel.
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An Unintended Language Is Displayed on the LCD
Select the language you want to be displayed according to the following procedure.

1. Press the MENU button, then wait for about 5 seconds.

2. Select  Setup, then press the OK button.

3. Select  Device settings, then press the OK button.

4. Press the  button 5 times, then press the OK button.
If the Bluetooth unit is connected to the machine, press the  button 7 times, then press the OK button.

5. Use the  button to select the language for the LCD, then press the OK button.
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Print Head Holder Does Not Move to the Position for Replacing

• Check 1: Are all lamps on the operation panel off?
Check if any lamp on the operation panel is lit.
The print head holder will not move unless the power is on. If all the lamps on the operation panel are off, close the
ink cover and the document cover and turn the machine on.
While any lamp on the operation panel is flashing, the machine is initializing. Wait until the lamp stops flashing and
remains lit, and then open the document cover and the ink cover again.

• Check 2: Is an error message displayed on the LCD?
Close the ink cover and the document cover, follow the Support Code (error number) displayed in the error message
to resolve the error, and then reopen them. For details on how to resolve the error, refer to Support Code List.

• Check 3: Have the document cover and the ink cover been left open for 10
minutes or longer?
If the document cover and the ink cover are left open for more than 10 minutes, the print head holder moves to the
right to prevent the print head from drying out. Close and reopen the ink cover and the document cover to return the
print head holder to the position for replacing.

• Check 4: Has the machine been printing continuously for a long period?
Close ink cover and the document cover, wait a while, then reopen them.
If the machine has been printing continuously for a long time, the print head holder may not move to the position for
replacing since the print head may overheat.

Note
Opening the document cover and the ink cover while printing moves the print head holder to the right. Close the ink

cover and the document cover, and reopen them after printing finishes.
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Printer Status Monitor Is Not Displayed

• Check: Is the printer status monitor enabled?
Make sure that Enable Status Monitor is selected on the Option menu of the printer status monitor.

1. Open the printer driver setup window.
How to Open the Printer Driver Setup Window

2. On the Maintenance sheet, click View Printer Status....

3. Select Enable Status Monitor on the Option menu if it is not selected.
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If the Output Tray Extension Comes Off
If the output tray extension comes off, the paper output tray is not closed properly.

Note
The output tray extension comes off easily to avoid it being damaged.

Hold the paper output tray and move the output tray extension slowly until it clicks into place.
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Problems with Bluetooth Communication
 Printer Cannot be Registered
 Printing Does Not Start
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Printer Cannot be Registered

• Check 1: Have MP Drivers been installed?
If you reinstall the MP Drivers, reinstall the MP Drivers using the Setup CD-ROM.

• Check 2: Is unsupported Bluetooth driver used?
Confirm that the Bluetooth driver installed on your computer is supported.

• Toshiba Windows 7, Windows Vista or Windows XP computer
Windows 7:
Click Start, and select All Programs, TOSHIBA, Bluetooth, then Bluetooth Settings.
On the Bluetooth Settings dialog, click the help button, the version number, then make sure that the version
number is 7.00.00 or later.
Windows Vista:
Click Start, and select All Programs, TOSHIBA, Bluetooth, then Bluetooth Settings.
On the Bluetooth Settings dialog, click the help button, the version number, then make sure that the version
number is 5.10.04 or later.
Windows XP:
Click Start, and select All Programs, TOSHIBA, Bluetooth, then Bluetooth Settings.
On the Bluetooth Settings dialog, click the help button, the version number, then make sure that the version
number is 3.00.10 or later.

• Windows 7 computer (except for Toshiba Windows 7 computers)
Log into a user account with the administrator privilege, and click Control Panel, then Hardware and Sound.
Make sure that the Add a Bluetooth Device is displayed in the dialog.

• Windows Vista (except for Toshiba Windows Vista computers)
Log into a user account with the administrator privilege, and click Control Panel, then Hardware and Sound.

Make sure that the  Bluetooth Devices icon is displayed in the dialog.
• Windows XP SP2 or later (except for Toshiba Windows XP computers)

Log into a user account with the administrator privilege, click Control Panel, then Printers and Other
Hardware.

Make sure that the  Bluetooth Devices icon is displayed in the dialog.
The operations may vary depending on your operating program. In this case, refer to your computer's operation
manual.

• Check 3: Is the printer name which you want to register displayed in the Printer
List?

• Make sure that the printer is turned on.
Confirming that the Power Is On

• Make sure that the printer is not operating.

• Check whether the Bluetooth unit is usable.
Make sure that the Bluetooth settings (Graphic LCD)/Bluetooth settings (Text LCD) screen can be displayed
on the LCD of the printer. If the screen cannot be displayed, remove the Bluetooth unit from the printer and
attach it once again.

Attaching to and Removing from the Printer

• Make sure that the Bluetooth settings (Graphic LCD)/Bluetooth settings (Text LCD) screen
can be displayed on the LCD of the printer, and try to register again.

• Check whether access from a Bluetooth-compatible device is refused.
Check the printer access setting displaying the Bluetooth settings (Graphic LCD)/Bluetooth settings (Text
LCD) screen on the LCD of the printer.

1. Display the Bluetooth settings (Graphic LCD)/Bluetooth settings (Text LCD) screen on the LCD of the
printer.
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For information about how to display the Bluetooth settings (Graphic LCD)/Bluetooth settings (Text
LCD) screen, refer to Changing the Machine Settings on the LCD.

2. Select Access refusal setting (Graphic LCD)/Access refusal (Text LCD).

3. Select OFF (Graphic LCD)/OFF (Text LCD), then use the OK button on the printer to confirm the selection.
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Printing Does Not Start

• Check 1: Is Bluetooth unit ready for use?
Make sure that the Bluetooth settings (Graphic LCD)/Bluetooth settings (Text LCD) screen can be displayed on
the LCD of the printer. If the screen cannot be displayed, remove the Bluetooth unit from the printer and attach it
once again.

Attaching to and Removing from the Printer
Make sure that the Bluetooth settings (Graphic LCD)/Bluetooth settings (Text LCD) screen can be displayed on
the LCD of the printer, and try to print again.
If the Bluetooth settings (Graphic LCD)/Bluetooth settings (Text LCD) screen is not yet displayed after you
remove the Bluetooth unit from the printer and attach it again, the Bluetooth unit may be faulty. In this case, contact
the service center.

• Check 2: Is there a problem with the location of the printer or is the distance
between the printer and computer too great?
The maximum communication distance between the printer and a computer is about 33 ft./10 m, but it varies
depending on the following conditions:

• Presence of obstacles between the communication equipment and radio wave conditions
• Location where magnetic fields, static electricity, or radio interference occurs
• Type of software and operating system used
• Receiver sensitivity and antenna performance of the communication equipment

Change the printer installation place or move the printer closer to the computer.

• Check 3: Is the printer to be used selected correctly?
Follow the procedure described below to select the printer to which the Bluetooth unit is attached.

1. Log into a user account with the administrator privilege.

2. Select items from Control Panel as shown below.

• In Windows 7, click Control Panel, then Devices and Printers under Hardware and Sound.
• In Windows Vista, click Control Panel, then Printers under Hardware and Sound.
• In Windows XP, click Control Panel, then Printers and Faxes under Printers and Other Hardware.

3. Click the  icon of the printer to be used for printing via Bluetooth communication.

By default, the icon name is "Canon XXX Printer (Copy X)".

Note
"X" is a device name or a digit. The number of digits may differ depending on the printer.

4. Select the printer properties.

• In Windows 7, select Printer properties.
• In Windows Vista, select Properties from the Organizemenu.
• In Windows XP, select Properties from the File menu.

5. Click the Ports tab and select an applicable printer from Port.
It may vary depending on how you authenticate the printer.
For Windows 7
When authenticating the printer as a Add a Bluetooth device in Control Panel
"BTHnnn (Canon XXX Printer (Copy X))" ("n" is a digit).
When authenticating the printer as a Bluetooth device using Bluetooth Settings built in the computer
"TBPnnn (Canon XXX Printer (Copy X))" ("n" is a digit)
For Windows Vista or Windows XP
When authenticating the printer as a Bluetooth device in Control Panel
"BTHnnn (Canon XXX Printer (Copy X))" ("n" is a digit).
When authenticating the printer as a Bluetooth device using Bluetooth Settings built in the computer
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"TBPnnn (Canon XXX Printer (Copy X))" ("n" is a digit)
For more information about how to register the printer, see step 4 in Preparation.

6. Click OK.

• Check 4: Is the message "This document failed to print" displayed?
• Do not retry printing. Check the Support Code on the LCD.

Clear the error according to Support Code List.
• When you use a Microsoft Bluetooth driver, make sure that the Printing (HCRP) service is effective on your

computer.

In Windows 7:
Click Control Panel. Select Devices and Printers under Hardware and Sound, then select the printer to be
used for Bluetooth communication. Right-click and select Properties.
Make sure that Printing (HCRP) on the Services sheet is checked.

In Windows Vista:
Click Control Panel, Bluetooth Devices under Hardware and Sound, then select the printer to be used for
Bluetooth communication and click Properties.
Make sure that Printing (HCRP) on the Services sheet is checked.

In Windows XP:
Click Control Panel, Bluetooth Devices under Printers and Other Hardware, then select the printer to be
used for Bluetooth communication and click Properties.
Make sure that Printing (HCRP) on the Services sheet is checked.

If Printing (HCRP) is not checked or the Printing (HCRP) service is not detected, follow the procedure below
and register the printer again.

1. Select items from Control Panel as shown below.

• In Windows 7, click Control Panel, then Devices and Printers under Hardware and Sound.
• In Windows Vista, Control Panel, then Printers under Hardware and Sound.
• In Windows XP, click Control Panel, then Printers and Faxes under Printers and Other Hardware.

2. Click the  icon of the printer for printing via Bluetooth communication.

3. Remove the printer following the procedure below.

• In Windows 7, select Remove device.
• In Windows Vista, select Delete from the Organize menu.
• In Windows XP, select Delete from the File menu.

4. Authenticate the printer as a Bluetooth device from Control Panel as shown below.

• In Windows 7, authenticate the printer as a Bluetooth device on Add a Bluetooth Device in Hardware
and Sound under Control Panel.

• In Windows Vista or Windows XP, authenticate the printer as a Bluetooth device on Bluetooth Devices,
in Control Panel.

For more information about the procedure, see Registering the Printer.
• This message is displayed when the print job is sent from the Bluetooth device while another print job through

the USB port is being printed out.
Printing will begin automatically when the print queue is finished.

• Printing cannot be carried out with Bluetooth communication from more than one computer at the same time. In
this case, this message is displayed on the computer during standing by.
Printing will begin automatically when the print queue is finished.

• Check 5: Were the MP Drivers installed after printer registration on Add a
Bluetooth Device (Bluetooth Devices in Windows Vista or Windows XP)?
If you have installed the MP Drivers after registering the printer as a Bluetooth device on Add a Bluetooth Device
(Bluetooth Devices in Windows Vista or Windows XP), delete the printer and then register it again.
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For more information about the procedure, see Preparation.
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Problems with Installation/Downloading
 Cannot Install the MP Drivers
 Easy-WebPrint EX Does Not Start Up or Easy-WebPrint EX Menu Does Not Appear
 How to Update MP Drivers in Network Environment
 Uninstalling IJ Network Tool
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Cannot Install the MP Drivers

• If the installation does not start even after the Setup CD-ROM is inserted into your
computer's disc drive:
Start the installation following the procedure below.

1. Select items from the Start menu as shown below.

• In Windows 7 or Windows Vista, click Start then Computer.
• In Windows XP, click Start then My Computer.

2. Double-click the  CD-ROM icon on the displayed window.
If the contents of the CD-ROM are displayed, double-click MSETUP4.EXE.

Note
If the CD-ROM icon is not displayed, try the following:

Remove the CD-ROM from your computer, then insert it again.
Restart your computer.

If the icon is not yet displayed, try different discs and see if they are displayed. If other discs are displayed, there
is a problem with the Setup CD-ROM. In this case, contact the service center.

• If you are unable to proceed beyond the Printer Connection screen:

Note
The printer is not detected. Check the connection. may be displayed depending on the computer you use.

• Check 1: Make sure that the USB cable is securely plugged in to the machine
and the computer.

• Check 2: Follow the procedure below to connect the machine and the
computer again.
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1. Turn the machine off.

2. Unplug the USB cable from the machine and the computer, then connect it again.

3. Turn the machine on.

• Check 3: If you cannot resolve the problem, follow the procedure below to
reinstall the MP Drivers.

1. Click Cancel.

2. Click Start Over on the Installation Failure screen.

3. Click Exit on the "PIXMA XXX" screen (where "XXX" is your machine's name), then
remove the CD-ROM.

4. Turn the machine off.

5. Restart the computer.

6. Make sure that you have no application software running.

7. Insert the CD-ROM again, then install the MP Drivers.

• In other cases:
Reinstall the MP Drivers.
If the MP Drivers were not installed correctly, uninstall the MP Drivers, restart your computer, and then reinstall the
MP Drivers.

Deleting the Unnecessary MP Drivers
If you reinstall the MP Drivers, install the MP Drivers on the Setup CD-ROM.

Note
If the installer was forced to be terminated due to a Windows error, the system may be in an unstable condition

and you may not be able to install the drivers. Restart your computer before reinstalling.
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Easy-WebPrint EX Does Not Start Up or Easy-WebPrint EX Menu Does
Not Appear
If Easy-WebPrint EX does not start up or its menu does not appear on Internet Explorer, confirm the following.

• Check 1: Is Canon Easy-WebPrint EX displayed on the Toolbars menu in the
Internet Explorer's View menu?
If Canon Easy-WebPrint EX is not displayed, Easy-WebPrint EX is not installed on your computer. Install Easy-
WebPrint EX onto your computer on the Setup CD-ROM.

Note
If Easy-WebPrint EX is not installed on your computer, a message asking you to install it may be displayed on

the notification area on the taskbar. Click the message, then follow the instructions on the computer screen to
install Easy-WebPrint EX.
While the installation or download Easy-WebPrint EX is in progress, it is necessary to access the Internet.

• Check 2: Is Canon Easy-WebPrint EX selected on the Toolbars menu in the
Internet Explorer's View menu?
If Canon Easy-WebPrint EX is not selected, Easy-WebPrint EX is disabled. Select Canon Easy-WebPrint EX to
enable it.
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How to Update MP Drivers in Network Environment
Download the latest MP Drivers in advance.
To obtain the latest MP Drivers, access our web site through the Internet and download the latest MP Drivers for your
model.
After uninstalling the MP Drivers, install the latest MP Drivers according to the regular procedure. When the connection
method selection screen is displayed, select Use the printer with wireless LAN connection or Use the printer with
wired LAN connection according to the connection method you use. The machine will be detected automatically in the
network.
After making sure that the machine is detected, install the MP Drivers following the on-screen instructions.

Note
You can use the machine over a LAN without performing setup again.
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Uninstalling IJ Network Tool
Follow the procedure below to uninstall IJ Network Tool from your computer.

Important
Even if IJ Network Tool is uninstalled, you can print, scan, and fax from the computer over network. However, you

cannot change the network settings over network.
Log into a user account with administrator privilege.

1. Uninstall IJ Network Tool.

• In Windows 7 or Windows Vista:

1. Click Start > Control Panel > Programs > Programs and Features.
2. Select Canon IJ Network Tool from the program list, then click Uninstall.

If the User Account Control screen appears, click Continue.
• In Windows XP:

1. Click Start > Control Panel > Add or Remove Programs.
2. Select Canon IJ Network Tool from the program list, then click Remove.

2. Click Yes when the confirmation message appears.
When the message prompting you to restart your computer is displayed, click OK to restart your computer.
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About Errors/Messages Displayed
 If an Error Occurs
 A Message for Faxing Is Displayed on the LCD
 A Message Is Displayed
 Error Message Appears on a PictBridge Compliant Device
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If an Error Occurs
When an error occurs in printing such as the machine is out of paper or paper is jammed, a troubleshooting message is
displayed automatically. Take the appropriate action described in the message.
When an error occurs, a Support Code (error number) is displayed on the computer screen or the LCD.

• When a Support Code and a message are displayed on the computer screen:

• When a Support Code and a message are displayed on the LCD:

For details on how to resolve errors with Support Codes, refer to Support Code List.

Note
You can confirm the actions against errors with Support Codes on your computer or on the LCD by searching a

Support Code.
Click Here to Search

For details on how to resolve errors without Support Codes, see A Message Is Displayed.
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A Message for Faxing Is Displayed on the LCD
If a message is displayed on the Fax standby screen, take the corresponding action described below.

Message Action

Auto redial

The machine is waiting to redial the recipient's number because the line
was busy or the recipient did not answer when you tried to send a
document. Wait for the machine to automatically redial the number. If
you want to cancel automatic redialing, wait until the machine starts
dialing the number, then press the Stop button. You can also delete the
document from machine's memory to cancel automatic redialing.

Resending Faxes (Redialing a Busy Number)

This group dial cannot be used.
Coded speed dial ##

* "##" represents a two-digit number.
You selected a coded speed dial code to which a group is registered
with the Hook button pressed.
A coded speed dial code to which a group is registered cannot be used
in this way.

Replace the receiver. The handset is not placed in the handset cradle correctly.
Replace the handset correctly.

Try again in black & white.

The recipient's fax machine is not color-compatible.
Press the Black button to resend the fax.
Alternatively, you select Send in black & white for Color transmission
in Advanced FAX settings under FAX settings. The machine converts
color documents into black & white data if the recipient's fax machine
does not support color faxing.

Advanced FAX settings

Failed to connect.

The telephone line cable with a modular plug may not be plugged in
properly.
Make sure that the cable is plugged in properly, and resend the fax after
a while. If you still cannot send the fax, select OFF for Dial tone detect
in Advanced FAX settings under FAX settings.

Advanced FAX settings

Received in memory. If the machine receives a fax under one of the following conditions, the
machine will not be able to print the received fax and will store it in the
machine's memory. When the problem is resolved as described, the fax
stored in the machine's memory is printed automatically.

• The amount of remaining ink is insufficient to print a fax:
Replace the ink tank.

Replacing an Ink Tank

Note
You can set the machine to forcibly print a received fax even if

the ink has run out.
Set Print when out of ink in Auto print settings under FAX
settings to Print.
However, part or all of the fax may not be printed since the ink
has run out.
Also, the contents of the fax will not be stored in the machine's
memory.
If the ink has already run out, we recommend that Do not print
be selected for Received documents in Auto print settings
under FAX settings to store the received fax in the machine's
memory. After you replace the ink tank and select Print for
Received documents in Auto print settings, the fax stored in
the machine's memory will be printed automatically.

Auto print settings

• Paper has run out:
Load the paper and press the OK button.

• A different size of paper from that specified by Page size is loaded:
Load the same size of paper as that specified by Page size, then
press the OK button.

• You pressed the Stop button to cancel printing of a fax:
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Press the FAX button to resume printing of the fax.
• Do not print is selected for Received documents in Auto print

settings under FAX settings:
You can print the faxes stored in the machine's memory from the
Memory reference screen in the Fax menu.

Printing a Document in Machine's Memory

Note
To print the received faxes automatically, select Print for

Received documents in Auto print settings under FAX settings.
Auto print settings

If you did not print the fax stored in the machine's memory (e.g., if
you did not resolve the problem by pressing the Stop button), you
can delete or print the fax stored in the machine's memory later.

Document Stored in Machine's Memory

Busy/no signal

• The recipient's number you dialed is busy.
Try dialing again after waiting for a moment.

Resending Faxes (Redialing a Busy Number)
• The fax/telephone number dialed is incorrect.

Check the fax/telephone number and dial again.
• The recipient's fax machine did not respond (after all automatic

redialing attempts).
Contact the recipient and have the recipient check the fax machine.
For an overseas call, add pauses to the registered number.

• The recipient is not using a G3 machine.
The machine cannot send or receive documents to/from a fax
machine that is incompatible with the G3 standard. Contact the
recipient and ask the recipient to check whether the fax machine is
G3 compatible.

• The touch tone/rotary pulse setting on the machine is incorrect.
Set the machine to match the telephone line you are using.

Setting the Telephone Line Type

Memory is full.

The machine's memory is full because it has sent/received too many
documents, or a detailed document.
Print the faxes stored in the machine's memory or save them on the
USB flash drive, and delete them from the machine's memory.

Document Stored in Machine's Memory
When sending a fax, resend it. If this message still appears, delete the
faxes stored in the machine's memory, divide the faxes for sending, and
send them again.
When receiving a fax, have the sender resend the faxes.

Awaiting document processing.

The received faxes were not saved on the USB flash drive automatically
because the USB flash drive was not inserted or because it was not
writable.
Press the OK button.
The received faxes are stored in the machine's memory. Insert the
writable USB flash drive, then save the received faxes to the USB flash
drive manually.

Saving a Document in Machine's Memory to USB Flash Drive
Delete the unnecessary fax from machine's memory after saving to the
USB flash drive.

Deleting a Document in Machine's Memory

FAX info does not match.

Transmission has been canceled because the machine could not detect
the recipient's fax machine information or the information did not match
the dialed number. This message is displayed when Check RX FAX
information in Security control under FAX settings is set to ON.
For details, see Sending Faxes after Checking Information (Checking
the Recipient's Information).

Reception rejected.

Reception has been rejected because the fax matches the fax rejection
condition specified by FAX reception reject in Security control under
FAX settings.
For details, see Rejecting Fax Reception.
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Waiting for report output...

If the machine receives a fax under one of the following conditions, the
machine will not be able to print the reports. When the problem is
resolved as described, the reports are printed automatically.

• The amount of remaining ink is insufficient to print a report:
Replace the ink tank.

Replacing an Ink Tank
• Paper has run out:

Load the paper and press the OK button.
• A different size of paper from that specified by Page size is loaded:

Load the same size of paper as that specified by Page size, then
press the OK button.

• You pressed the Stop button to cancel printing of a report:
Press the FAX button to resume printing of the report.
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A Message Is Displayed
This section describes some of the errors or messages.

Note
A Support Code (error number) is displayed on the computer or on the LCD for some error or message. For details

on errors with Support Codes, refer to Support Code List.

If a message is displayed on the LCD, see below.

• A Message Is Displayed on the LCD
If a message is displayed on the computer, see below.

• Error Regarding Automatic Duplex Printing Is Displayed
• Error Regarding the Power Cord Being Unplugged Is Displayed
• Writing Error/Output Error/Communication Error
• Other Error Messages
• The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is Displayed

A Message Is Displayed on the LCD
Confirm the message and take an appropriate action.

• Data of supported types are not saved.
• There is no image data or document saved on the USB flash drive that can be read by this machine.
• The machine may not recognize the file if the file name or folder path contain certain characters. Use only

alphanumeric characters.
• Photo data edited or processed on a computer must be printed from the computer.

Note
When a photo which has been processed on a computer is selected, "?" is displayed on the LCD.

• Cannot print the specified PDF file. An error has occurred while scanning the file, or
the format is not supported, or the file is too large.

• Make sure the PDF file is printable from a USB flash drive. See Printing Documents (PDF File) Saved on a USB
Flash Drive for more information.

Note
The names of the PDF files are displayed even though they cannot be printed from the USB flash drive. It

is recommended you confirm whether they are printable. If one of the following conditions applies to the
PDF files, they are not printable.

The Details screen is not displayed for the PDF file you want to print.
Characters other than machine name, IJ Scan Utility, or My Image Garden are displayed on

Created with on the Details screen.
"?" is displayed on the preview screen.

• Data edited or processed on a computer must be printed from the computer.

• The specified PDF file contains unprintable data. Some portions may not be printed.
PDF file which contain lot of graphics or hi-resolution images may lose that data or stop before printing is completed.
In this case, print from the computer.

• Check the page size and select .
The size of the loaded paper is different from that specified in the paper size setting.
Load the same size of paper as that specified in the paper size setting, then press the OK button.

• Power was not turned off correctly the last time. Press the  button when turning
power off.
The power cord may have been unplugged last while the machine was still on.
Press the OK button to dismiss the error.

Note
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See Notice for Unplugging the Power Cord for unplugging the power cord.

• The power cord has been unplugged and unsent/received docs in memory have been
lost.
A power failure has occurred or the power cord has been unplugged when the faxes are stored in the machine's
memory.

Important
If a power failure occurs or you unplug the power cord, all faxes stored in the machine's memory are deleted.
For details on how to unplug the power cord, see Notice for Unplugging the Power Cord.

Press the OK button.
After pressing the OK button, the list of the faxes deleted from the machine's memory (MEMORY CLEAR REPORT)
will be printed.
For details, refer to Summary of Reports and Lists.

Error Regarding Automatic Duplex Printing Is Displayed

• Check: See Cannot Print Properly with Automatic Duplex Printing and take the appropriate action.

Error Regarding the Power Cord Being Unplugged Is Displayed
The power cord may have been unplugged while the machine was still on.
Check the error message that appears on the computer, then click OK.
The machine starts printing.
See Notice for Unplugging the Power Cord for unplugging the power cord.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.

Writing Error/Output Error/Communication Error

• Check 1: If all the lamps on the operation panel are off, make sure that the power plug is plugged
in, then turn the machine on.
While any lamp on the operation panel is flashing, the machine is initializing. Wait until the lamp on the operation
panel stops flashing and remains lit.

• Check 2: Make sure that the printer port is configured appropriately in the printer driver.
* In the following instructions, "XXX" signifies your machine's name.

1. Log on as a user account with administrator privilege.

2. Select items from the Start menu as shown below.

• In Windows 7, select Devices and Printers from the Start menu.
• In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.
• In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware > Printers and

Faxes.

3. Open the properties of printer driver for the machine.

• In Windows 7, right-click the "Canon XXX Printer" icon (where "XXX" is your machine's name), then select
Printer properties.

• In Windows Vista or Windows XP, right-click the "Canon XXX Printer" icon (where "XXX" is your
machine's name), then select Properties.

4. Click the Ports tab to confirm the port settings.
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Make sure that a port named "USBnnn" (where "n" is a number) with "Canon XXX Printer" appearing in the
Printer column is selected for Print to the following port(s).

Note
When the machine is used over LAN, the port name of the machine is displayed as

"CNBJNP_xxxxxxxxxx". "xxxxxxxxxx" is the character string generated from the MAC address or a character
string specified by the user when setting up the machine.

• If the setting is incorrect:
Reinstall the MP Drivers.

• Printing does not start even though the machine is connected to the computer using a USB cable and the
port named "USBnnn" is selected:
Click Start and select All programs, Canon Utilities, Canon My Printer, Canon My Printer, then select
Diagnose and Repair Printer. Follow the on-screen instructions to set the correct printer port, then select
your machine's name.
If the problem is not resolved, reinstall the MP Drivers.

• Printing does not start even though the port named "CNBJNP_xxxxxxxxxx" is selected when the machine
is used over LAN:
Launch IJ Network Tool, and select "CNBJNP_xxxxxxxxxx" as you confirmed in step 4, then associate the
port with the printer using Associate Port in the Settings menu.
If the problem is not resolved, reinstall the MP Drivers.

• Check 3: Make sure that the machine is connected to your computer properly.
When the machine is connected to your computer with a USB cable, make sure that the USB cable is securely
plugged in to the machine and the computer, then check the followings:

• If you are using a relay device such as a USB hub, disconnect it, connect the machine directly to the computer,
and try printing again. If printing starts normally, there is a problem with the relay device. Consult the reseller of
the relay device for details.

• There could also be a problem with the USB cable. Replace the USB cable and try printing again.
When you use the machine over LAN, make sure that the machine is connected to the network with a LAN cable or is
set up correctly.

• Check 4: Make sure that the MP Drivers are installed correctly.
Uninstall the MP Drivers following the procedure described in Deleting the Unnecessary MP Drivers, insert the Setup
CD-ROM into the computer's disc drive and install the MP Drivers again.

• Check 5: When the machine is connected to your computer with a USB cable, check the status of
the device on your computer.
Follow the procedure below to check the status of the device.

1. Open the Device Manager on your computer as shown below.

If the User Account Control screen is displayed, follow the on-screen instructions.
• In Windows 7 or Windows Vista, click Control Panel, Hardware and Sound, then Device Manager.
• In Windows XP, click Control Panel, Performance and Maintenance, System, then click Device

Manager on the Hardware sheet.

2. Double-click Universal Serial Bus controllers then USB Printing Support.
If the USB Printing Support Properties screen is not displayed, make sure that the machine is correctly
connected to the computer.

Check 3: Make sure that the machine is connected to your computer properly.

3. Click the General tab and make sure that there is no indication of a problem with the device.

If a device error is displayed, refer to Windows help to resolve the error.

Other Error Messages

• Check: If an error message is displayed outside the printer status monitor, check the following:
• "Could not spool successfully due to insufficient disk space"

Delete any unnecessary files to increase the amount of free space on the disk.
• "Could not spool successfully due to insufficient memory"
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Quit other running application softwares to increase available memory.
If you cannot print yet, restart your computer and retry printing.

• "Printer driver could not be found"
Uninstall the printer driver according to the procedure described in Deleting the Unnecessary MP Drivers, and
then reinstall it.

• "Could not print Application name - File name"
Try printing again once the current job is complete.

The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is Displayed
If the Inkjet Printer/Scanner/Fax Extended Survey Program is installed, a confirmation screen asking for permission to
send the printer and application software usage information will be displayed every month for about ten years.
Read the instructions on the screen and follow the procedure below.

• If you agree to participate in the survey program:
Click Agree, then follow the on-screen instructions. The printer usage information will be sent via the Internet. If you
have followed the on-screen instructions, the information will be sent automatically from the second time onward and
the confirmation screen will not be displayed again.

Note
When the information is being sent, a caution screen such as an Internet security screen may be displayed. In

this case, confirm that the program name is "IJPLMUI.exe", then allow it.
If you deselect the Send automatically from the next time check box, the information will not be sent

automatically from the second time onward and a confirmation screen will be displayed at the time of the next
survey. To send the information automatically, see Changing the confirmation screen setting:.

• If you do not agree to participate in the survey program:
Click Do not agree. The confirmation screen will be closed, and the survey at that time is skipped. The confirmation
screen will be displayed again one month later.

• To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program:
To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program, click Uninstall, then follow the on-screen
instructions.

• Changing the confirmation screen setting:
1. Select items from the Start menu as shown below.

• In Windows 7 or Windows Vista, select the Start menu > Control Panel > Programs > Programs and
Features.

• In Windows XP, select the Start menu > Control Panel > Add or Remove Programs.

Note
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In Windows 7 or Windows Vista, a confirmation/warning dialog box may appear when installing,
uninstalling or starting up software.
This dialog box appears when administrative rights are required to perform a task.
If you are logged on to an administrator account, follow the on-screen instructions.

2. Select Canon Inkjet Printer/Scanner/Fax Extended Survey Program.
3. Select Change.

If you select Yes after you have followed the on-screen instructions, the confirmation screen will be displayed at
the time of the next survey.
If you select No, the information will be sent automatically.

Note
If you select Uninstall (or Remove in Windows XP), the Inkjet Printer/Scanner/Fax Extended Survey

Program is uninstalled. Follow the on-screen instructions.
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Error Message Appears on a PictBridge Compliant Device
The following are the possible errors that may occur when printing directly from a PictBridge compliant device and the
countermeasures to clear them.

Note
This section describes errors that are indicated on Canon-brand PictBridge compliant devices. The error messages

and operations may vary depending on the device you are using. For errors on non-Canon PictBridge compliant
devices, check the Support Code (error number) on the LCD and take the appropriate action to clear the error.

Support Code List
For the errors indicated on the PictBridge compliant device and their solution, also refer to the instruction manual of

the device. For other troubles on the device, contact the manufacturer.

Error Message on the PictBridge Compliant
Device Action

"Printer in use"
If the machine is printing from the computer or warming up, wait until the
job ends.
When it is ready, the machine starts printing automatically.

"No paper"

Load paper in the cassette, and select Continue* in the display on your
PictBridge compliant device.
* To resume printing, you can also press the OK button on the machine
instead of selecting Continue on the device.
See Cannot Print on the Disc Label for disc label printing.

"Paper Error"

If the paper output tray is closed, open it and select Continue* in the
display on your PictBridge compliant device.
* To resume printing, you can also press the OK button on the machine
instead of selecting Continue on the device.
If the inner cover (the cover of the disc tray) is opened, close it and
select Stop in the display on your PictBridge compliant device to stop
printing.
See Cannot Print on the Disc Label for disc label printing.

"Paper jam"

Select Stop in the display on your PictBridge compliant device to stop
printing.
Remove the jammed paper, load new paper, press the OK button on the
machine, and try printing again.

"Printer cover open" Close the ink cover on the machine.

"Waste tank full"/"Ink absorber full"

The ink absorber is nearly full.
Check the Support Code on the LCD and take the appropriate action to
resolve the error.

Support Code List

"No ink"/"Ink cassette error"

• The ink tank is not installed. Install the ink tank.
Replacing an Ink Tank

• The ink tank is not compatible with this machine.
Printing cannot be executed because the ink tank is not compatible
with this machine.
Install an appropriate ink tank.
If you want to cancel printing, press the machine's Stop button.

Replacing an Ink Tank
• If the lamp on the ink tank is flashing, ink may have run out.

Check the Support Code on the LCD and take the appropriate action
to resolve the error.

Support Code List

"Ink Error"

An ink tank that was once empty is installed.
Check the Support Code on the LCD and take the appropriate action to
resolve the error.

Support Code List

"Hardware Error"
The ink tank cannot be recognized. (The lamp on the ink tank is off.)
Replace the ink tank.

Replacing an Ink Tank
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"Printer error"

An error requiring servicing may have occurred.
Turn off the machine, and unplug the power cord of the machine from
the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the

machine's memory are deleted.
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If You Cannot Resolve the Problem
If you cannot resolve the problem with any of the workarounds in this chapter, please contact the seller of the machine or
the service center.
Canon support staff are trained to be able to provide technical support to satisfy customers.

Caution
If the machine emits any unusual sound, smoke, or odor, turn it off immediately. Unplug the power cord from the

outlet and contact the seller or the service center. Never attempt to repair or disassemble the machine yourself.
Attempts by customers to repair or take apart the machine will invalidate any warranty regardless of whether the

warranty has expired.

Before contacting the service center, confirm the following:

• Product name:
* Your machine's name is located on the front cover of the setup manual.

• Serial number: please refer to the setup manual
• Details of the problem
• What you tried to solve the problem, and what happened
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Support Code List
The support code appears on the LCD and the computer screen when an error occurs.
"Support Code" means the error number and appears with an error message.
When an error occurs, check the support code displayed on the LCD or the computer screen and take the appropriate
action.

Support Code Appears on the LCD and the Computer Screen

• 1000 to 1ZZZ

1001 1002 1007 1008 1200 1253

1300 1304 1310 1311 1312 1313

1401 1403 1405 1410 1411 1412

1413 1414 1600 1660 1680 1681

1683 1684 1688 1700 1701 1710

1711 1830 1850 1851 1855 1856

1857 1858     

• 2000 to 2ZZZ

2001 2002 2500 2700 2800 2801

2802 2803 2804    

• 4000 to 4ZZZ

4100 4101     

• 5000 to 5ZZZ

5011 5012 5100 5101 5200 5400

5B00 5B01 5B10 5B11 5C00 5C20

• 6000 to 6ZZZ

6000 6001 6002 6500 6502 6800

6801 6900 6901 6902 6910 6911

6920 6921 6930 6931 6932 6933

6936 6937 6938 6939 693A 6940

6941 6942 6943 6944 6945 6946

6A81 6B10 6B20    

• 9000 to 9ZZZ

9000 9500     

• A000 to ZZZZ

B200 C000     

About the support code for paper jam, you can also refer to Support Code List (When Paper Is Jammed).
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Support Code List (When Paper Is Jammed)
If the paper is jammed, remove it following the procedure appropriate for each case.

• If you can see the jammed paper at the paper output slot:
1300

• If the paper is jammed when automatic duplex printing:
1304

• If the paper loaded in the cassette (upper) is jammed:
1311

• If the paper loaded in the cassette (lower) is jammed:
1312

• If the paper is jammed as the machine pulled in the printed paper:
1313

• If the paper tears and you cannot remove it from the paper output slot or from the transport unit:
Paper Is Jammed inside the Machine

• If the document is jammed in the ADF:
2801

• Cases other than above:
In Other Cases
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1300

Cause
Paper is jammed in the paper output slot.

Action
If you can see the jammed paper at the paper output slot, remove the paper following the procedure below.

Important
The power cannot be turned off while the machine is sending or receiving a fax, or when the received fax or the

unsent fax are stored in the machine's memory.
Make sure if the machine completed sending or receiving all the faxes before disconnecting the power cord.
If you unplug the power cord, all the faxes stored in the machine's memory are deleted.

Note
If you need to turn off the machine to remove jammed paper during printing, press the Stop button to cancel print

jobs before turning off the machine.

1. Pull the paper out slowly.

Hold the paper with your hands, then pull the paper out slowly not to tear it.

Note
If you cannot pull the paper out, turn the machine off and turn it back on. The paper may be ejected

automatically.
If the paper tears and you cannot remove the jammed paper from the paper output slot, remove the paper from

inside the machine.
Paper Is Jammed inside the Machine

2. Reload the paper, and press the OK button on the machine.

If you turned off the machine in step 1, all print jobs in the queue are canceled. Reprint if necessary.

Note
When reloading the paper, confirm that you are using the paper suited for printing and are loading it correctly.
We recommend you use paper other than A5 sized one to print documents with photos or graphics; otherwise,

the printout may curl and cause paper exit jams.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues after removing
the paper, contact the service center.
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1304

Cause
Paper is jammed when performing automatic duplex printing.

Action
If the paper is jammed when performing automatic duplex printing, remove the paper following the procedure below.

Important
The power cannot be turned off while the machine is sending or receiving a fax, or when the received fax or the

unsent fax are stored in the machine's memory.
Make sure if the machine completed sending or receiving all the faxes before disconnecting the power cord.
If you unplug the power cord, all the faxes stored in the machine's memory are deleted.

Note
If you need to turn off the machine to remove jammed paper during printing, press the Stop button to cancel print

jobs before turning off the machine.

1. Detach the rear cover.

Pull out the rear cover.

2. Detach the transport unit cover.

Lift up the transport unit cover, then pull it out.

3. Pull out the paper slowly.

Note
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Do not touch the inner parts of the machine.
If you cannot pull out the paper, open the paper output tray.

4. Attach the transport unit cover.

Insert the transport unit cover to the back of the machine.

5. Attach the rear cover.

Insert the rear cover to the back of the machine.

If you were not able to remove the paper out in step 3:

6. Detach the lower and upper cassettes.

7. Pull out the paper slowly.

8. If the paper is not loaded properly in the cassette, remove the paper, then reload it after aligning the edges of the
sheets.

Note
When reloading the paper, confirm that you are using the paper suited for printing and are loading it correctly.

9. Attach the cassettes to the machine, then press the OK button.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues after removing
the paper, contact the service center.
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1311

Cause
The paper loaded in the cassette (upper) is jammed.

Action
If the paper loaded in the cassette (upper) is jammed, remove the paper following the procedure below.

Important
The power cannot be turned off while the machine is sending or receiving a fax, or when the received fax or the

unsent fax are stored in the machine's memory.
Make sure if the machine completed sending or receiving all the faxes before disconnecting the power cord.
If you unplug the power cord, all the faxes stored in the machine's memory are deleted.

Note
If you need to turn off the machine to remove jammed paper during printing, press the Stop button to cancel print

jobs before turning off the machine.

1. Detach the rear cover.

Pull out the rear cover.

2. Detach the transport unit cover.

Lift up the transport unit cover, then pull it out.

3. Pull out the paper slowly.

Note
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Do not touch the inner parts of the machine.
If you cannot pull out the paper, open the paper output tray.

4. Attach the transport unit cover.

Insert the transport unit cover to the back of the machine.

5. Attach the rear cover.

Insert the rear cover to the back of the machine.

If you were not able to remove the paper out in step 3:

6. Detach the lower and upper cassettes.

7. Pull out the paper slowly.

8. If the paper is not loaded properly in the cassette, remove the paper, then reload it after aligning the edges of the
sheets.

Note
When reloading the paper, confirm that you are using the paper suited for printing and are loading it correctly.

9. Attach the cassettes to the machine, then press the OK button.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues after removing
the paper, contact the service center.
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1312

Cause
The paper loaded in the cassette (lower) is jammed.

Action
If the paper loaded in the cassette (lower) is jammed, remove the paper following the procedure below.

Important
The power cannot be turned off while the machine is sending or receiving a fax, or when the received fax or the

unsent fax are stored in the machine's memory.
Make sure if the machine completed sending or receiving all the faxes before disconnecting the power cord.
If you unplug the power cord, all the faxes stored in the machine's memory are deleted.

Note
If you need to turn off the machine to remove jammed paper during printing, press the Stop button to cancel print

jobs before turning off the machine.

1. Detach the rear cover.

Pull out the rear cover.

2. Pull out the paper slowly.

Note
Do not touch the inner parts of the machine.
Open the paper output tray if you cannot pull out the paper.

3. Attach the rear cover.

Insert the rear cover to the back of the machine.
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If you were not able to remove the paper out in step 2:

4. Detach the lower and upper cassettes.

5. Pull out the paper slowly.

6. If the paper is not loaded properly in the cassette, remove the paper, then reload it after aligning the edges of the
sheets.

Note
When reloading the paper, confirm that you are using the paper suited for printing and are loading it correctly.

7. Attach the cassettes to the machine, then press the OK button.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues after removing
the paper, contact the service center.
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1313

Cause
The paper is jammed as the machine pulled in the printed paper.

Action
If the paper is jammed as the machine pulled in the printed paper, remove the paper following the procedure below.

Important
If the printed paper piles up on the paper output slot, the machine may pull it in and the paper is jammed inside the

machine. Remove the printed paper from the paper output tray before it amounts to 50 sheets.
The power cannot be turned off while the machine is sending or receiving a fax, or when the received fax or the

unsent fax are stored in the machine's memory.
Make sure if the machine completed sending or receiving all the faxes before disconnecting the power cord.
If you unplug the power cord, all the faxes stored in the machine's memory are deleted.

Note
If you need to turn off the machine to remove jammed paper during printing, press the Stop button to cancel print

jobs before turning off the machine.

1. Detach the rear cover.

Pull out the rear cover.

2. Detach the transport unit cover.

Lift up the transport unit cover, then pull it out.

3. Pull out the paper slowly.
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Note
Do not touch the inner parts of the machine.
If you cannot pull out the paper, open the paper output tray.

4. Attach the transport unit cover.

Insert the transport unit cover to the back of the machine.

5. Attach the rear cover.

Insert the rear cover to the back of the machine.

If you were not able to remove the paper out in step 3:

6. Detach the lower and upper cassettes.

7. Pull out the paper slowly.

8. If the paper is not loaded properly in the cassette, remove the paper, then reload it after aligning the edges of the
sheets.

Note
When reloading the paper, confirm that you are using the paper suited for printing and are loading it correctly.

9. Attach the cassettes to the machine, then press the OK button.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues after removing
the paper, contact the service center.
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2801

Cause
The document is jammed in the ADF.

Action
Remove the document following the procedure below.

Important
The power cannot be turned off while the machine is sending or receiving a fax, or when the received fax or the

unsent fax are stored in the machine's memory.
Make sure if the machine completed sending or receiving all the faxes before disconnecting the power cord.
If you unplug the power cord, all the faxes stored in the machine's memory are deleted.

• If the original remains in the ADF by pressing the Stop button while the machine is scanning the
document:
If you press the Stop button during scanning then the document remained in the ADF, the message about the paper
remained in the ADF appears on the LCD. Press the OK button so that the remaining document is automatically fed
out.

• If the original is jammed in the ADF:
Remove the document following the procedure below.

1. If printing is in progress, press the Stop button.

2. Turn off the machine.

3. If a multi-page document is loaded, remove any pages other than the jammed page from the ADF, then open the
document feeder cover.

4. Raise the paper release lever, then pull out the jammed page in the ADF, either from the document tray or from
the document output slot, whichever is easier.
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If the document cannot be pulled out with ease, raise the document cover and pull out the jammed page from the
inner side of the document cover.

After pulling out the jammed page, close the document cover.

Note
When checking whether a piece of paper remains inside the ADF, see In Other Cases:.

5. Close the document feeder cover, then turn on the machine.

When rescanning the document after clearing the error, rescan it from the first page.
If you cannot remove the document or the document tears inside the machine, or if the document jam error continues
after removing the document, contact the service center.

Note
The document may not feed properly depending on the media type, or your environment, such as when the

temperature and humidity are either too high or too low.
In this case, reduce the number of document pages to approximately half of the loading capacity.
If the document still jams, use the platen glass instead.

• In Other Cases:
If you cannot find the jammed page or you want to remove the piece of paper after checking whether it remains inside
the ADF, follow the procedure below.

1. If printing is in progress, press the Stop button.

2. Turn off the machine.

3. If a multi-page document is loaded, remove any pages other than the jammed page from the ADF, then open the
document feeder cover.

4. Open the transport cover (A), then remove the jammed page or the piece of paper that remains inside the ADF.
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5. First close the transport cover, next close the document feeder cover, then turn on the machine.

When rescanning the document after clearing the error, rescan it from the first page.
If you cannot remove the document or the document tears inside the machine, or if the document jam error continues
after removing the document, contact the service center.

164



Paper Is Jammed inside the Machine
If the jammed paper tears and you cannot remove the paper either from the paper output slot or the jammed paper
remains inside the machine, remove the paper following the procedure below.

Important
The power cannot be turned off while the machine is sending or receiving a fax, or when the received fax or the

unsent fax are stored in the machine's memory.
Make sure if the machine completed sending or receiving all the faxes before disconnecting the power cord.
If you unplug the power cord, all the faxes stored in the machine's memory are deleted.

Note
If you need to turn off the machine to remove jammed paper during printing, press the Stop button to cancel print

jobs before turning off the machine.

1. Turn off the machine, and unplug the power cord of the machine from the power supply.

2. Open the document cover and the ink cover.

Important
Do not touch the clear film (A) or the white belt (B).

If the paper or your hands touch these parts and blot or scratch them, the machine can be damaged.

3. Make sure that the jammed paper is not under the print head holder.
If the jammed paper is under the print head holder, move the print head holder to the right edge or the left edge
whichever is easier to remove the paper.
When you move the print head holder, hold the top of the print head holder and slide it slowly to the right edge or the
left edge.

165



4. Hold the jammed paper with your hands.

If the paper is rolled up, pull it out.

5. Pull the paper slowly not to tear it, then pull the paper out.
Keep an angle of the paper about 45 degrees and pull it slowly.
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6. Make sure that all the jammed paper is removed.
If the paper is torn, a piece of paper may remain inside the machine. Check the following and remove the piece of
paper if it remains.

• Does the piece of paper remain under the print head holder?
• Does the little piece of paper remain inside the machine?
• Does the piece of paper remain in the right side or the left side space (C) inside the machine?

7. Close the ink cover and the document cover.
All print jobs in the queue are canceled. Reprint if necessary.

Note
When reloading the paper, confirm that you are using the paper suited for printing and are loading it correctly. If

the message about paper jam is displayed on the LCD of the machine or on the computer screen when you
resume printing after removing all the jammed paper, a piece of paper may remain inside the machine. In this
case, confirm that no piece of paper remains inside the machine.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues after removing
the paper, contact the service center.

167



In Other Cases
Make sure of the following:

• Check 1: Are there any foreign objects around the paper output slot?

• Check 2: Are the transport unit cover and the rear cover attached properly?

• Check 3: Is the paper curled?
Load the paper after correcting its curl.
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1001

Cause
There is no disc tray.

Action
When printing on printable discs (BD/DVD/CD, etc.), use the disc tray supplied with this machine ("J" is on the upper side).
Place a printable disc on the disc tray, attach the disc tray to the machine, then press the OK button.
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1002

Cause
Printable disc (BD/DVD/CD, etc.) is not set.

Action
When printing on printable discs, use the disc tray supplied with this machine ("J" is on the upper side). Place a printable
disc on the disc tray, attach the disc tray to the machine, then press the OK button.
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1007

Cause
Possible causes include the following.

• There is no paper in the cassette (upper).
• The paper source is incorrect.
• Paper is not loaded properly.

Action
Take the corresponding actions below.

• Load paper in the cassette (upper).
• Load paper in the paper source suitable for the paper size.

The small size photo paper such as 4" x 6" (10 x 15 cm) or 5" x 7" (13 x 18 cm), or Hagaki can be loaded in the
cassette (upper).

Important
If you cut plain paper into small size such as 4" x 6" (10 x 15 cm) or 5" x 7" (13 x 18 cm) and try to print on it,

the paper jam will occur.

• Align the paper guides with the both edges of the paper when you load paper.
After carrying out the above measures, press the OK button to dismiss the error.
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1008

Cause
Possible causes include the following.

• There is no paper in the cassette (lower).
• The paper source is incorrect.
• Paper is not loaded properly.

Action
Take the corresponding actions below.

• Load paper in the cassette (lower).
• Load paper in the paper source suitable for the paper size.

The large size photo paper or plain paper such as A4, B5, A5, 8" x 10" (20 x 25 cm), Letter, or Legal, or envelope can
be loaded in the cassette (lower).

• Align the paper guides with the both edges of the paper when you load paper.
After carrying out the above measures, press the OK button to dismiss the error.
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1200

Cause
The ink cover is open.

Action
Close the ink cover and wait for a while.
Do not close it while you are replacing an ink tank.
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1253

Cause
The paper output tray did not open.

Action
Open the paper output tray, then press the OK button.
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1310

Cause
The size of paper may not be compatible with automatic duplex printing.

Action
The sizes of media suitable for auto duplex printing are A4, Letter, A5, B5, and Hagaki. Make sure that the size of the
paper loaded in the machine is correct. Pressing the OK button will eject the paper and restart printing from the front side
of the next paper. The reverse side of the ejected sheet will not be printed.
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1401

Cause
The print head may be damaged.

Action
Contact the service center.
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1403

Cause
The print head may be damaged.

Action
Contact the service center.
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1405

Cause
The print head may be damaged.

Action
Contact the service center.
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1410

Cause
The ink tank cannot be recognized.

Action
Open the ink cover and replace the ink tank which lamp is off.
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1411

Cause
The ink tank cannot be recognized.

Action
Open the ink cover and replace the ink tank which lamp is off.
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1412

Cause
The ink tank cannot be recognized.

Action
Open the ink cover and replace the ink tank which lamp is off.
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1413

Cause
The ink tank cannot be recognized.

Action
Open the ink cover and replace the ink tank which lamp is off.
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1414

Cause
The ink tank cannot be recognized.

Action
Open the ink cover and replace the ink tank which lamp is off.
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1600

Cause
If the lamp on the ink tank is flashing, ink may have run out.

Action
Replacing the ink tank is recommended.
If printing is in progress and you want to continue printing, press the machine's OK button with the ink tank installed. Then
printing can continue. Replacing the ink tank is recommended after the printing. The machine may be damaged if printing
is continued under the ink out condition.

Note
If multiple ink lamps are flashing red, check the status of each ink tank.
Since the information contained in the fax may be lost if it is printed in this condition, the received fax will not be

printed and will be stored in the machine's memory until the ink is replaced. You must manually print out faxes that
were stored in the memory. You can change the setting so that the received fax is forcibly printed out instead of being
stored in the memory, but all or part of the fax information may not be printed because of the ink out condition.
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1660

Cause
The ink tank is not installed.

Action
Install the ink tank.
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1680

Cause
Some ink tanks are not installed in the correct position. (The lamp on the ink tank flashes.)

Action
Confirm that the ink tanks are installed in the appropriate positions.
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1681

Cause
More than one ink tanks of the same color are installed. (The lamp on the ink tank flashes.)

Action
Confirm that the ink tanks are installed in the appropriate positions.
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1683

Cause
The remaining ink level cannot be correctly detected. (The lamp on the ink tank flashes.)

Action
Replace the ink tank and close the ink cover.
Printing with an ink tank that was once empty may damage the machine.
If you want to continue printing in this condition, you need to release the function for detecting the remaining ink level.
Press and hold the machine's Stop button for at least 5 seconds, and then release it.
With this operation, releasing the function for detecting the remaining ink level is memorized. Please be advised that
Canon shall not be liable for any machine malfunction or damage caused by refilled ink tanks.

Note
If the function for detecting the remaining ink level is disabled, the ink tank in gray is displayed on the LCD when

checking the current ink level.
Since the information contained in the fax may be lost if it is printed in this condition, the received fax will not be

printed and will be stored in the machine's memory until the ink is replaced. You must manually print out faxes that
were stored in the memory. You can change the setting so that the received fax is forcibly printed out instead of being
stored in the memory, but all or part of the fax information may not be printed because of the ink out condition.
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1684

Cause
The ink tank cannot be recognized.

Action
Printing cannot be executed because the ink tank may not be installed properly or may not be compatible with this
machine.
Install the appropriate ink tank.
If you want to cancel printing, press the machine's Stop button.
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1688

Cause
The ink has run out. (The lamp on the ink tank flashes.)

Action
Replace the ink tank and close the ink cover.
Printing under the current condition may damage the machine.
If you want to continue printing in this condition, you need to release the function for detecting the remaining ink level.
Press and hold the machine's Stop button for at least 5 seconds, and then release it.
With this operation, releasing the function for detecting the remaining ink level is memorized. Please be advised that
Canon shall not be liable for any malfunction or trouble which may be caused by continuation of printing under the ink out
condition.

Note
If the function for detecting the remaining ink level is disabled, the ink tank in grey is displayed in the remaining ink

volume screen on the LCD.
Since the information contained in the fax may be lost if it is printed in this condition, the received fax will not be

printed and will be stored in the machine's memory until the ink is replaced. You must manually print out faxes that
were stored in the memory. You can change the setting so that the received fax is forcibly printed out instead of being
stored in the memory, but all or part of the fax information may not be printed because of the ink out condition.
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1700

Cause
The ink absorber is almost full.

Action
Press the machine's OK button to continue printing. Contact the service center.
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1701

Cause
The ink absorber is almost full.

Action
Press the machine's OK button to continue printing. Contact the service center.
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1710

Cause
The ink absorber is almost full.

Action
Press the machine's OK button to continue printing. Contact the service center.
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1711

Cause
The ink absorber is almost full.

Action
Press the machine's OK button to continue printing. Contact the service center.
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1830

Cause
A certain period of time has elapsed while disc label printing is in progress.

Action
If a certain period of time has elapsed while disc label printing is in progress, the machine stops initializing.
The machine resumes initializing by pressing the OK button.
Try the operation again following the instructions on the LCD.
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1850

Cause
The inner cover (the cover of the disc tray) is closed.

Action
Open the inner cover, attach the disc tray properly, then press the OK button to dismiss the error.
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1851

Cause
The inner cover (the cover of the disc tray) is open.

Action
When printing other than disc label printing is started, close the inner cover.
Close the inner cover, then press the OK button.
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1855

Cause
The inner cover (the cover of the disc tray) has been closed.

Action
Open the inner cover, then press the OK button to dismiss the error.
Do not open or close the inner cover while printing is in progress. Doing so may damage the machine.
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1856

Cause
The inner cover (the cover of the disc tray) has been opened.

Action
When printing other than disc label printing is started, close the inner cover.
Close the inner cover, then press the OK button.
Do not open or close the inner cover while printing is in progress. Doing so may damage the machine.
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1857

Cause
The inner cover (the cover of the disc tray) is open when starting disc label printing.

Action
When starting disc label printing, close the inner cover for the machine to prepare to print.
Close the inner cover, then press the OK button.
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1858

Cause
The inner cover (the cover of the disc tray) is open after replacing the ink tank.

Action
After replacing the ink tank, close the inner cover and the ink cover.
Press the OK button on the machine to dismiss the error.
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2001

Cause
The device incompatible with the machine is connected.

Action
Check the device connected to the USB flash drive port. Printing photos directly is possible with the optional Bluetooth
Unit BU-30 or a USB flash drive.
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2002

Cause
An unsupported USB hub is connected.

Action
If a USB flash drive is connected via a USB hub, remove the hub.
Connect a USB flash drive directly to the machine.
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2500

Cause
The cause of following may have occurred the failure of Automatic Print Head Alignment.

• Print head nozzles are clogged.
• The paper of size other than A4 or Letter is loaded in the cassette (lower).
• The paper output slot is exposed to strong light.

Action
Press the OK button on the machine to dismiss the error, then take the actions described below.

• Print the nozzle check pattern to check the status of the print head.
• Load a sheet of A4/Letter-sized Canon Matte Photo Paper MP-101 with the printing side (whiter side) facing UP and

perform Automatic Print Head Alignment again.
• Adjust your operating environment and/or the position of the machine so that the paper output slot is not exposed

directly to strong light.
After carrying out the above measures, if the problem continues after aligning the Print Head again, press the OK button to
dismiss the error, and then perform Manual Print Head Alignment.
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2700

Cause
Possible causes include the following.

• Some errors occurred while copying and a certain time passed.
• Document is remained in the ADF.
• Some errors occurred while scanning and the document is remained in the ADF.

Action
Take the corresponding actions below.

• When you copy, press the OK button to dismiss the error, and try to copy again.
• When the document is remained in the ADF, press the OK button to feed out the document.
• When you scan, press the Stop button to cancel the scanning, and try to scan again.

205



2800

Cause
The document feeder cover is open.

Action
Close the document feeder cover, then press the OK button.
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2802

Cause
No document in the ADF.

Action
Press the OK button to resolve the error, then operate again after loading documents.
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2803

Cause
The document is too long or is jammed in the ADF.

Action
Press the OK button to dismiss the error. Then make sure that the document you are loading meets the machine's
requirements before redoing the operation.
If the document is jammed, remove the jammed document following the procedure below.

• If the original is jammed in the ADF:
Remove the document following the procedure below.

1. If printing is in progress, press the Stop button.

2. Turn off the machine.

3. If a multi-page document is loaded, remove any pages other than the jammed page from the ADF, then open the
document feeder cover.

4. Raise the paper release lever, then pull out the jammed page in the ADF, either from the document tray or from
the document output slot, whichever is easier.

If the document cannot be pulled out with ease, raise the document cover and pull out the jammed page from the
inner side of the document cover.
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After pulling out the jammed page, close the document cover.

Note
When checking whether a piece of paper remains inside the ADF, see In Other Cases:.

5. Close the document feeder cover, then turn on the machine.

When rescanning the document after clearing the error, rescan it from the first page.
If you cannot remove the document or the document tears inside the machine, or if the document jam error continues
after removing the document, contact the service center.

Note
The document may not feed properly depending on the media type, or your environment, such as when the

temperature and humidity are either too high or too low.
In this case, reduce the number of document pages to approximately half of the loading capacity.
If the document still jams, use the platen glass instead.

• In Other Cases:
If you cannot find the jammed page or you want to remove the piece of paper after checking whether it remains inside
the ADF, follow the procedure below.

1. If printing is in progress, press the Stop button.

2. Turn off the machine.

3. If a multi-page document is loaded, remove any pages other than the jammed page from the ADF, then open the
document feeder cover.

4. Open the transport cover (A), then remove the jammed page or the piece of paper that remains inside the ADF.
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5. First close the transport cover, next close the document feeder cover, then turn on the machine.

When rescanning the document after clearing the error, rescan it from the first page.
If you cannot remove the document or the document tears inside the machine, or if the document jam error continues
after removing the document, contact the service center.
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2804

Cause
The size of the document is not suitable for duplex scanning.

Action
Press the OK button to dismiss the error.
Size of the document suitable for automatic duplex scanning: A4, Letter
Make sure that the document you are loading meets the machine's requirements before redoing the operation.
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4100

Cause
The specified data cannot be printed.

Action
When you print the contents on CREATIVE PARK PREMIUM, confirm the message on the computer screen, make sure
that genuine Canon ink tanks are installed properly for all colors, then start printing again.
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4101

Cause
The machine does not support the paper size you specified.

Action
Press the Stop button, specify the proper paper size, then print again.
If you print on the non-standard size paper, you can specify a custom size within the following range to print.

• Loading in the cassette (upper):
-Width: 89.0 mm to 200.0 mm (3.50 inches to 7.87 inches)
-Height: 127.0 mm to 184.9 mm (5.00 inches to 7.28 inches)

• Loading in the cassette (lower):
-Width: 90.0 mm to 215.9 mm (3.54 inches to 8.50 inches)
-Height: 185.0 mm to 355.6 mm (7.29 inches to 14.00 inches)
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5011

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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5012

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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5100

Cause
Printer error has occurred.

Action
Cancel printing, and turn off the machine. Then clear the jammed paper or protective material that is preventing the print
head holder from moving, and turn on the machine again.

Important
Be careful not to touch the components inside the machine. The machine may not print out properly if you touch it.
If the problem is not resolved, contact the service center.
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5101

Cause
Printer error has occurred.

Action
Remove the protective material that is preventing the print head holder from moving, turn the machine off, and turn it back
on.
If the problem is not resolved, contact the service center.
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5200

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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5400

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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5B00

Cause
Printer error has occurred.

Action
Contact the service center.
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5B01

Cause
Printer error has occurred.

Action
Contact the service center.
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5B10

Cause
Printer error has occurred.

Action
Contact the service center.
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5B11

Cause
Printer error has occurred.

Action
Contact the service center.
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5C00

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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5C20

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6000

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6001

Cause
Printer error has occurred.

Action
If the paper output tray is closed, open it.
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
Do not close the paper output tray while the machine is in operation; otherwise, an error will occur.
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6002

Cause
Printer error has occurred.

Action
If the paper output tray is closed, open it.
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
Do not close the paper output tray while the machine is in operation; otherwise, an error will occur.
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6500

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6502

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6800

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6801

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6900

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6901

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6902

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6910

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6911

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6920

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6921

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6930

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6931

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6932

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6933

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6936

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6937

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6938

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6939

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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693A

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6940

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6941

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.

250



6942

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6943

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6944

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6945

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6946

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6A81

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6B10

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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6B20

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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9000

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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9500

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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B200

Cause
An error requiring you to contact the service center has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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C000

Cause
Printer error has occurred.

Action
Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.
If the problem is not resolved, contact the service center.

Important
If you disconnect the power plug, all the faxes stored in the machine's memory are deleted.
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